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T1: Introduction to the MatCalc graphical user interface (GUI) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.001 
license: free 
database: none 
  
This first tutorial provides a brief tour of MatCalc's user interface and explains how to perform basic 
file operations. 

Contents 

• Appearance of the graphical user interface 
• Menus and toolbar 
• Console window 
• Command history 
• Configuring the layout of the GUI 
• The 'File' menu 
• Creating a new workspace file 
• Modifying the working directory 
• Adding workspace information 
• Saving and closing files 
• Getting help 
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1. The graphical user interface 

Screen layout 

When MatCalc is first opened, the screen appears as shown below (Windows version). 

 
  
The table below gives brief descriptions of the different areas of the screen. 
  

Menu bar  The main menu (see below).  

Toolbar Icons giving quick access to frequently used functions (see below)  

Console Window for entering command-lines; more information is given below and in Tutorial 12. 

Options window  
Context-sensitive options to change the way information is displayed. Tutorial 2, Tutorial 
4 and Tutorial 5 give more information about the Options window. 

Variables window  
A list of MatCalc's built-in variables with their current values. See Tutorial 4 and Tutorial 
5 for more about variables. 

Information on 
variables  

Notes on the currently highlighted entry in the variables window (meaning of variable, 
units, etc.). 

Status bar  
Gives information on the current state of the system (temperature, time, etc.) and on 
the contents of graphical windows (see Tutorial 4). 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
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Menu bar 

As with any typical GUI application, this gives access to a number of sub-menus. The 'File' and 
'Help' menus are documented in this tutorial, and the contents of the other menus will be 
described in more detail in subsequent tutorials. 
'File': opening, saving and closing files (see 'File operations' below)  
'Edit': text-editing commands such as undo, redo, cut, copy, paste  
'Global': commands for setting up the system  
'Calc': commands for starting various types of calculation  
'Extra': to run scripts (more on this in Tutorial 13)  
'View': to configure the GUI and create new windows for the display of results 
'Help': see 'Getting help' below 

Toolbars 

The toolbar area contains a number of icon groups: 
  
'File etc' 

 
L-R : New file, open, save, close, print, help 
  
'Toolbar' 

 
L-R: Choose working directory, launch script 
  
'Edit' 

 
L-R: Undo, redo, cut, copy, paste, search 
  
'Calculation' 

 
L-R: Stop, Single equilibrium, stepped equilibrium, search phase boundary, precipitation 
calculation, choose calculation state, load into calculation state, load into buffer, choose buffer. 
  
'Manage windows' 

 
L-R: Show console, create new window 
  
Right-clicking on the toolbar area gives a menu allowing the user to control which windows and 
which icon groups are to be displayed on the screen: 
  

 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t13
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Console 

This window allows command-line input, as an alternative to using the graphical controls. 
Commands can also be grouped into script files, for easier and more rapid execution of repetitive 
or complex tasks. More on the console, command-line syntax and scripts will be found in Tutorial 
12: Using the MatCalc console and Tutorial 13: Introduction to scripting. The console can be shown 

or hidden using View > Show console, pressing F4 key or clicking on icon. 

Command history 

The command history window can be made to appear by selecting its entry in the menu shown on 
the picture above. It gives a chronological list of all the commands entered in the Console. 
  

 
  
A command can be selected using the mouse pointer or arrow keys. Right-clicking on the command 
displays the following menu. On the right-hand side of the menus in MatCalc are keyboard 
shortcuts for the more commonly used commands. It can be seen from the image below that it is 
sufficient to press the 'Enter' key to execute the selected command. 
  

 
  
Previously used commands can also be accessed in the Console window itself; pressing the up-
arrow key displays the most recently entered command, and pressing it repeatedly scrolls through 
recent commands in reverse chronological order. The command displayed can be edited then 
executed by pressing the 'Enter' key. 

Configuring the layout 

The icon groups in the toolbar can be rearranged by clicking on the double vertical lines at the left-
hand side of the group and dragging to the chosen location. They can be detached from the toolbar 
area and brought into the currently empty main window area (coloured grey); in this case, they are 
given title bars similar to that of the 'MatCalc console'. The Console, Options, Variables and 
Command History windows can also be attached to or detached from the left-hand column area as 
required. 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t13
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t13
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2. File operations 

The 'File' menu 

Clicking on 'File' in the menu bar opens the following menu: 
  

 
  

Creating a new workspace file 

The 'workspace' is the basic file type in MatCalc. It contains all the necessary information on the 
calculation or series of calculations under consideration, comprising inputs (elements, phases, 
compositions, thermodynamic and mobility data) and outputs (results of calculations, graphs, etc.). 
Saving the workspace preserves all this information for future use. 

Click on the  icon or open 'New' from the 'File' menu. The following dialogue box will appear: 
  

 
  
Select 'MatCalc workspace' from the drop-box. This runs a script file called 'autonew.mcs', 
which makes three additional windows appear: 'Output', 'Phase details' and 'Phase summary'. 
When the new workspace is first created, the 'Output' window displays licence and version 
information and the 'Phase summary' and 'Phase details' windows show messages indicating 
that no phases have yet been selected. The workspace is now ready for thermodynamic or 
precipitation calculations to be set up and performed. 
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Working directory 

The 'working directory' is the directory opened by default when saving new files or opening 
existing ones. Clicking on 'Working directory...' allows the user to designate an existing directory 
as the working directory or to create a new directory for this purpose. 
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The paths of the current working directory and of recently used working directories are listed to the 
right of 'Recent working dirs...', allowing any of these directories to be selected easily. 
  

 
  
The same information is also available in a drop-box in the toolbar area: 
  

 

Adding workspace information 

Clicking on 'Workspace info...' opens a box in which information about the current workspace can 
be entered. This is useful for details of the assumptions used in the calculation, the sources of 
experimental data, etc. 
  

 

Save, Save as, close 

Workspaces can be saved using 'Save...' or 'Save As...' in the file menu, or the icon on the 

toolbar. To close a file, choose 'Close Workspace' in the file menu or . Warning: do not close 
the individual windows on the screen before saving, or their contents will not be saved! 
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3. Getting help 

Click on the icon on the toolbar or open the 'Help' menu to open the help browser. In the 
Console, typing a question-mark will display a list of available commands. These will be discussed 
more fully in Tutorial 12. 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
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T2: Calculating a single equilibrium 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  
  
This tutorial explains how to determine the equilibrium phases at a given temperature, and their 
phase fractions and compositions. 

Contents 

• Opening a database and selecting elements and phases 
• Entering a composition  
• Calculating an equilibrium at a given temperature  
• Interpretation of information displayed in the output, phase summary and phase details 

windows  
• Using the 'Options' window to modify the display  
• Phase status indicators  
• Calculation states  

Before starting... 

Create a new workspace file (Tutorial 1). 
 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t2:script:t2.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t1
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1. Setting up the system 

Opening a thermodynamic database and selecting elements and phases 

In the 'Global' menu, select 'Databases'. A window will appear as shown below. The 
'Equilibrium database' box initially displays the message 'database not open...'. Click on the 
'open...' button; this will open the '...MatCalc/database' subdirectory, allowing the user to 
choose a database. A small database on iron-based materials, 'mc_sample_fe.tdb', is provided 
with MatCalc for demonstration purposes. Select this database and click 'Open'. 
  

 
  
A list of elements will appear in the left-hand box, with FE and VA (vacancies) selected by default. 
In the right-hand box is a list of the phases which can occur in a system containing the selected 
elements. Click on 'C' in the elements box; this will add to the list a number of other phases which 
can occur in an Fe-C system, such as graphite and several carbides. The 'show all available 
phases' box can be used to display all the phases available in the database, irrespective of 
whether they can form in the system in question. 
From the phase list, select 'LIQUID', 'BCC_A2', 'FCC_A1', 'GRAPHITE' and 'CEMENTITE'. 
Phases are described using crystallographic notation: BCC_A2 represents the body-centred cubic 
phase, which corresponds to ferrite in the iron-carbon system, and FCC_A1 is the face-centred 
cubic austenite phase in Fe-C. Click 'Read' then 'close' 
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Entering the composition 

In the 'Global' menu, select 'Composition'. This opens the 'System composition' box. The 
lower part of the box gives options for the units in which the composition is to be displayed: mole 
fraction, weight fraction, u-fraction or weight percent. One of the elements, usually the one with 
the highest mole fraction, is designated as the 'reference element', and the amount of this 
element is calculated as 1-(sum of the amounts of all other elements) for compositions 
expressed in fractional form, or 100-(sum of the amounts of all other elements) for 
compositions expressed as percentages.  
Iron is set as the reference element by default in the 'mc_sample_fe.tdb' database, as can be seen 
from the 'Ref. Elem' column in the composition dialogue box. Another element can be set as the 
reference by selecting the element name and clicking on the 'Set reference element' button on 
the right, or by double-clicking in the 'Ref. Elem' column by the side of the element name. 
To enter a composition of 0.4 wt.% C, select 'weight percent' as the unit, then highlight 
element C. Double-click in the 'Amount' column, click on the 'Change' button or press F2 to 
modify the composition, then type in '0.4' and press 'Enter'.  
The system is now ready to perform an equilibrium calculation. 
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2. Calculating an equilibrium 

From the 'Calc' menu, select 'Set start values'. This initialises the calculation variables with 
reasonable values in order to help the Gibbs free energy minimiser to find a solution which satisfies 
all the boundary conditions. This command is useful if the solution algorithm seems to be 'stuck' 
and unable to find an equilibrium. 
  
Once one valid equilibrium has been found, solutions at other temperatures or boundary conditions 

are much easier to obtain. From the 'Calc' menu, select 'Equilibrium', or click on the icon in the 
toolbar. The following window appears: 
  

 
  
Enter '700' in the temperature box and ensure that 'temperature in C' is selected. Leave the 
pressure at its default value. Click on 'Go' to start the calculation. 

Interpreting the results of the calculation 

The 'Output', 'Phase status' and 'Phase details' windows each show information on the 
calculation which has just been performed. The final three lines of the Output window list the 
number of iterations, the calculation time, the temperature and the Gibbs energy of the system. 
The '- OK -' message in the final line indicates that the calculation was successful, with no errors 
reported. If any errors do occur, the message '*** error ***' followed by a description of the 
nature of the error will be displayed instead of the 'OK' message. In this case, reset the calculation 
with 'Set start values' and repeat it using 'Equilibrium'. It is always advisable to check the 
status of the calculation in the Output window before proceeding. 
The other lines visible in the Output window are messages relating to the opening and reading of 
the thermodynamic database. 
  



Tutorial 2 

 14

 
  
Information on the phase stabilities is shown in the 'Phase summary' window. Those phases with 
non-zero phase fractions are termed 'active' and are listed in the first block. Inactive phases 
(those which are unstable, with negative driving forces) are listed in the second block. The third 
column gives the phase fraction and the column after 'dfm:' gives the driving force in J/mole. It 
can be seen that BCC_A2 (ferrite) and GRAPHITE are the stable phases at 700°C. 
  

 
  
The 'Phase details' window provides more comprehensive information on the properties of the 
phases, including the molar Gibbs free energy of the phase (the number after 'gm:') and the phase 
compositions (expressed in mole fraction by default), as well as the information provided in the 
'Phase summary'. The phases are again grouped according to whether they are active or inactive. 
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Using the 'Options' window to modify the display 

To change the units in which the composition is displayed in the 'Phase details' window, first 
highlight this window and then go to the 'Options' window. (If this is not shown on the screen, 
make it appear by selecting 'View > Show options window' or right-clicking in the toolbar area 
and selecting 'options' from the menu.) 
The 'Options' window provides display options for the currently highlighted window. In the case of 
the 'Phase details' window, the composition can be displayed as a mole fraction, a weight fraction 
or a u-fraction, and can also be expressed as a percentage if required. 
  

 

Phase status: suspended and dormant phases 

The calculation has shown that at 700°C, BCC_A2 (ferrite) and graphite are the equilibrium (i.e. 
most thermodynamically stable) phases. However, it is observed in practice that in Fe-C systems 
with relatively low carbon contents, graphite formation is extremely slow, and can be considered 
not to occur over practical timescales.  
Since this is the case, it is useful to calculate a metastable equilibrium, for which graphite 
formation is not allowed. Go to 'Global > Phase status' and highlight 'GRAPHITE'. In the 
'General' tab, the uppermost section is labelled 'Flags...'. Click to place a tick in the box next to 
'suspended'. 
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Repeat the equilibrium calculation and note the difference in results in the 'Phase summary' 
window: 
  
BCC_A2 * act 9.29184e-001 dfm: +0.00000e+000 
CEMENTITE act 7.08157e-002 dfm: +0.00000e+000 
### inactive ### 
FCC_A1 - OK - 0.00000e+000 dfm: -1.19832e+002 
LIQUID - OK - 0.00000e+000 dfm: -3.71990e+003 
### suspended ### 
GRAPHITE 
  
Now BCC_A2 and CEMENTITE are active, FCC_A1 and LIQUID are inactive and GRAPHITE is listed 
as 'suspended'. Suspending a phase causes the program to consider it as if it were not there at 
all; the next most stable phase (in this case, cementite) becomes the equilibrium phase. 
Alternatively, the flag can be set to 'dormant' using the same procedure. In this case, the phase is 
considered not to appear, but its driving force is still evaluated. In this case, cementite does not 
become active, as shown by the results below: 
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BCC_A2 * act 9.82166e-001 dfm: +0.00000e+000 
### inactive ### 
GRAPHITE dorm. 1.78337e-002 dfm: +0.00000e+000 
FCC_A1 - OK - 0.00000e+000 dfm: -1.88360e+002 
CEMENTITE - OK - 0.00000e+000 dfm: -5.82261e+002 
LIQUID - OK - 0.00000e+000 dfm: -4.07902e+003 
  
In order to eliminate graphite completely from the system, it is necessary to re-load the 
thermodynamic data from the database. Re-open 'Global > Databases' and click on GRAPHITE 
to unselect it, then click on 'Read'. A warning will appear, stating that all existing data will be 
deleted. Accept this by clicking on 'Yes'. A new message, with updated information on the 
thermodynamic data, appears in the 'Output' window. Reading in new data from the database 
erases any previous equilibrium calculation results, so repeat the equilibrium calculation at 700°C 
to obtain an equilibrium without graphite. The driving forces obtained should be identical to those 
found in the previous calculation in which graphite was suspended: 
  
BCC_A2 * act 9.29184e-001 dfm: +0.00000e+000 
CEMENTITE act 7.08157e-002 dfm: +0.00000e+000 
### inactive ### 
FCC_A1 - OK - 0.00000e+000 dfm: -1.19832e+002 
LIQUID - OK - 0.00000e+000 dfm: -3.71990e+003 

Calculation states 

By default, the results from a previous equilibrium calculation are overwritten when a new 
calculation is carried out. However, it is sometimes useful to store the results from a calculation for 
future use. The 'Calculation states' feature is provided for this purpose; it can be found in the 
'Global' menu under 'CalcStates'. In the sub-menu, click on 'Create' and type the name in the 
box: 
  

 
  
The calculation state stores all information on an equilibrium including the complete phase status, 
composition and any compositional states which may apply. Calculate another equilibrium at 600°C 
and store it in another calculation state. These states are now both available in the calculation 
state drop-box on the toolbar: 
  

 

Select a calculation state from this box and load the stored equilibrium with the button (This 
can also be done using 'Global > CalcStates > Select' and then 'Load' ). Note how the contents 
of the 'Phase details' and 'Phase summary' windows are immediately updated with the results 
stored in the calculation state, and the temperature at which the equilibrium was calculated is 
shown in the status bar towards the bottom right of the screen. The results of the current 
equilibrium calculation can be saved into an existing calculation state by selecting the name of the 

state in the drop-box and then clicking on the  button or using 'Global > CalcStates > Select' 
and then 'Save'. NB: Calculation states, like all other calculation results, are erased when 
data is re-read from the database! 
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To finish... 

Save the workspace using 'File > Save as...'. Workspace files are automatically given the file 
extension '.mcw'. 
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T3: Stepped equilibrium calculations 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents 

• Re-opening a saved file and loading a calculation state 
• Calculating a stepped equilibrium with varying temperature  
• Understanding the results in the Output window  
• Working with multiple buffers  
• Calculating a stepped equilibrium with varying composition  
• The "Edit buffer states" window  

Before starting... 

Re-open the file saved from Tutorial 2 and load the calculation state 'Equil @ 600°C'. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t3:script:t3.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
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1. Stepped equilibrium calculation with varying temperature 

Running the stepped calculation 

Select 'Stepped calculation...' from the 'Calc' menu or click on the icon. The 'Step 
equilibrium' window will appear. Select 'Temperature' (the uppermost choice in the left-hand 
column). 
In the 'Range' box, the default 'Start', 'Stop' and 'Step interval' values are 400, 1600 and 25 
respectively. Keep these values and verify that the 'Temperatures in Celsius' option has been 
selected. The step direction is unimportant, and it is not necessary to enter the interval as '-25' if 
stepping in a negative direction. The contents of the 'Vary' and 'Boundary conditions' boxes are 
currently greyed-out because they are not applicable to a temperature-step calculation. Click on 
the 'Go' button at the bottom right of the window. 
  

 

Output 

The 'Output' window should show the following series of messages: 
  
1, 0.00 s, 600.00 C (873.16 K), its 2, BCC_A2 CEMENTITE - OK -  
2, 0.00 s, 625.00 C (898.16 K), its 4, BCC_A2 CEMENTITE - OK - 
3, 0.00 s, 650.00 C (923.16 K), its 4, BCC_A2 CEMENTITE - OK - 
4, 0.00 s, 675.00 C (948.16 K), its 4, BCC_A2 CEMENTITE - OK - 
5, 0.00 s, 700.00 C (973.16 K), its 4, BCC_A2 CEMENTITE - OK - 
6, 0.02 s, 725.00 C (998.16 K), its 4, BCC_A2 CEMENTITE - OK - 
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Tsol 'FCC_A1': 726.62 C (999.78 K) iter: 4, time used: 0.00 s 
Tsol 'CEMENTITE': 726.62 C (999.78 K) iter: 5, time used: 0.00 s 
7, 0.05 s, 750.00 C (1023.16 K), its 5, FCC_A1 BCC_A2 - OK - 
8, 0.02 s, 775.00 C (1048.16 K), its 5, FCC_A1 BCC_A2 - OK - 
Tsol 'BCC_A2': 787.13 C (1060.29 K) iter: 4, time used: 0.00 s 
9, 0.00 s, 800.00 C (1073.16 K), its 4, FCC_A1 - OK - 
10, 0.00 s, 825.00 C (1098.16 K), its 2, FCC_A1 - OK - 
11, 0.00 s, 850.00 C (1123.16 K), its 2, FCC_A1 - OK - 
12, 0.01 s, 875.00 C (1148.16 K), its 2, FCC_A1 - OK - 
13, 0.00 s, 900.00 C (1173.16 K), its 2, FCC_A1 - OK - 
14, 0.00 s, 925.00 C (1198.16 K), its 2, FCC_A1 - OK - 
15, 0.00 s, 950.00 C (1223.16 K), its 2, FCC_A1 - OK - 
16, 0.00 s, 975.00 C (1248.16 K), its 2, FCC_A1 - OK - 
17, 0.02 s, 1000.00 C (1273.16 K), its 2, FCC_A1 - OK - 
18, 0.00 s, 1025.00 C (1298.16 K), its 2, FCC_A1 - OK - 
19, 0.00 s, 1050.00 C (1323.16 K), its 2, FCC_A1 - OK - 
20, 0.00 s, 1075.00 C (1348.16 K), its 2, FCC_A1 - OK - 
21, 0.00 s, 1100.00 C (1373.16 K), its 2, FCC_A1 - OK - 
22, 0.00 s, 1125.00 C (1398.16 K), its 2, FCC_A1 - OK - 
23, 0.00 s, 1150.00 C (1423.16 K), its 2, FCC_A1 - OK - 
24, 0.00 s, 1175.00 C (1448.16 K), its 2, FCC_A1 - OK - 
25, 0.00 s, 1200.00 C (1473.16 K), its 2, FCC_A1 - OK - 
26, 0.02 s, 1225.00 C (1498.16 K), its 2, FCC_A1 - OK - 
27, 0.00 s, 1250.00 C (1523.16 K), its 2, FCC_A1 - OK - 
28, 0.00 s, 1275.00 C (1548.16 K), its 2, FCC_A1 - OK - 
29, 0.00 s, 1300.00 C (1573.16 K), its 2, FCC_A1 - OK - 
30, 0.00 s, 1325.00 C (1598.16 K), its 2, FCC_A1 - OK - 
31, 0.01 s, 1350.00 C (1623.16 K), its 2, FCC_A1 - OK - 
32, 0.00 s, 1375.00 C (1648.16 K), its 2, FCC_A1 - OK - 
33, 0.00 s, 1400.00 C (1673.16 K), its 2, FCC_A1 - OK - 
34, 0.00 s, 1425.00 C (1698.16 K), its 2, FCC_A1 - OK - 
35, 0.00 s, 1450.00 C (1723.16 K), its 2, FCC_A1 - OK - 
Tsol 'LIQUID': 1453.05 C (1726.21 K) iter: 3, time used: 0.00 s 
36, 0.00 s, 1475.00 C (1748.16 K), its 3, LIQUID FCC_A1 - OK - 
Tsol 'FCC_A1': 1494.60 C (1767.76 K) iter: 4, time used: 0.00 s 
Tsol 'BCC_A2': 1494.60 C (1767.76 K) iter: 5, time used: 0.01 s 
37, 0.03 s, 1500.00 C (1773.16 K), its 5, LIQUID BCC_A2 - OK - 
Tsol 'BCC_A2': 1505.64 C (1778.80 K) iter: 4, time used: 0.00 s 
38, 0.02 s, 1525.00 C (1798.16 K), its 4, LIQUID - OK - 
39, 0.00 s, 1550.00 C (1823.16 K), its 2, LIQUID - OK - 
40, 0.02 s, 1575.00 C (1848.16 K), its 2, LIQUID - OK - 
41, 0.00 s, 1600.00 C (1873.16 K), its 2, LIQUID - OK - 
changing step direction ... 
42, 0.01 s, 575.00 C (848.16 K), its 5, BCC_A2 CEMENTITE - OK - 
43, 0.00 s, 550.00 C (823.16 K), its 5, BCC_A2 CEMENTITE - OK - 
44, 0.00 s, 525.00 C (798.16 K), its 5, BCC_A2 CEMENTITE - OK - 
45, 0.00 s, 500.00 C (773.16 K), its 5, BCC_A2 CEMENTITE - OK - 
46, 0.00 s, 475.00 C (748.16 K), its 5, BCC_A2 CEMENTITE - OK - 
47, 0.00 s, 450.00 C (723.16 K), its 5, BCC_A2 CEMENTITE - OK - 
48, 0.01 s, 425.00 C (698.16 K), its 5, BCC_A2 CEMENTITE - OK - 
49, 0.00 s, 400.00 C (673.16 K), its 5, BCC_A2 CEMENTITE - OK - 
50, 0.02 s, 400.00 C (673.16 K), its 2, BCC_A2 CEMENTITE - OK - 
Steps: 51, CalcTime: 0.45 s 
AktStepVal: 673.160000 
- OK - 
  
Each line corresponds to an equilibrium calculated at a single temperature value and comprises a 
line number, the calculation time, the temperature, the number of iterations, the stable phases at 
that temperature and an '- OK -' message indicating that the equilibrium calculation was 
successful. 
Note that the temperature-stepping starts from the equilibrium at 600°C loaded from the 
calculation state. Initially, the temperature is increased by the 'Step interval' each time until the 
upper temperature limit is reached. Then, a 'changing step direction' message is displayed and, 
again starting from the equilibrium at 600°C, the temperature is decreased until the lower limit is 
reached.  
Also note the lines beginning with 'Tsol': phase solubility temperatures are automatically evaluated 
during the stepped calculation. Thus it is seen in the output below that from 600°C to 726.62°C, 
the two stable phases are BCC_A2 (ferrite) and CEMENTITE. At 726.62°C, FCC_A1 (austenite) 
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becomes stable, and cementite becomes unstable. The two phases in equilibrium are ferrite and 
austenite between this temperature and 787.14°C, when ferrite becomes unstable. Austenite is 
then the only stable phase, and this situation persists up to the liquid solubility temperature of 
1453.05°C. The BCC_A2 phase known as delta-ferrite is stable in a narrow temperature range at 
high temperature, and by 1600°C the only equilibrium phase is liquid. There are no changes in 
phase stability between 600°C and 400°C, as can be seen from the block of lines below 'changing 
step direction'. 
The final three lines of output give the number of steps and total calculation time, the current value 
of the stepped variable (673.16 K = 400°C) and an 'OK' message indicating that the calculation 
was carried out successfully. 
The contents of the 'Phase summary' and 'Phase details' are not modified during the stepped 
calculation, but still display the information loaded from the calculation state 'Equil @ 600°C'. 

Buffers 

All the equilibria listed above are stored in a buffer. The default buffer is named '_default_', and 
its contents are overwritten when a new stepped calculation is carried out. 
To be able to keep more than one set of stepped equilibria, additional buffers must be created. 
Firstly, rename the existing default buffer using 'Global > Buffers > Rename'. Type 'T=400 to 
1600°C' into the 'New buffer name' box and click 'OK'. Then, create a new buffer using 'Global 
> Buffers > Create'. This new buffer will contain the results from a new stepped equilibrium 
calculation in which the carbon content is varied from 0 to 1.5 wt.% at 500°C, so enter the name 
'C=0 to 1.5 at 500°C'. Note that buffers can be selected from the drop-box in the toolbar area or 
using 'Global > Buffers > Select'. 
  

 

2. Stepped equilibrium calculation with varying carbon content 

Running the calculation 

Calculate an equilibrium at 500°C. Open the 'Step equilibrium' window again, but this time select 
'Element cont..' instead of 'Temperature' in the 'Type' box. Enter '0', '1.5' and '0.05' 
respectively as the start, stop and step interval values. (Note that, as shown in the image below, 
MatCalc accepts either a decimal point or a comma as the decimal separator.)  
In the 'Boundary conditions' box, ensure that the element selected is 'C', and enter the 
temperature as '500'. Ensure that in the 'vary' box, 'global comp' is selected, and that in the 
'Options' column, 'Temperatures in Celsius' and 'Composition in weight percent' are both 
selected, then click on 'Go'. 
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The contents of the 'Output' window should appear as follows: 
  
1, 0,00 s, 0,4, its 2, BCC_A2 CEMENTITE - OK -  
2, 0,00 s, 0,45, its 2, BCC_A2 CEMENTITE - OK - 
3, 0,00 s, 0,5, its 2, BCC_A2 CEMENTITE - OK - 
4, 0,00 s, 0,55, its 2, BCC_A2 CEMENTITE - OK - 
5, 0,00 s, 0,6, its 2, BCC_A2 CEMENTITE - OK - 
6, 0,00 s, 0,65, its 2, BCC_A2 CEMENTITE - OK - 
7, 0,00 s, 0,7, its 2, BCC_A2 CEMENTITE - OK - 
8, 0,00 s, 0,75, its 2, BCC_A2 CEMENTITE - OK - 
9, 0,00 s, 0,8, its 2, BCC_A2 CEMENTITE - OK - 
10, 0,00 s, 0,85, its 2, BCC_A2 CEMENTITE - OK - 
11, 0,00 s, 0,9, its 2, BCC_A2 CEMENTITE - OK - 
12, 0,00 s, 0,95, its 2, BCC_A2 CEMENTITE - OK - 
13, 0,00 s, 1, its 2, BCC_A2 CEMENTITE - OK - 
14, 0,00 s, 1,05, its 2, BCC_A2 CEMENTITE - OK - 
15, 0,00 s, 1,1, its 2, BCC_A2 CEMENTITE - OK - 
16, 0,00 s, 1,15, its 2, BCC_A2 CEMENTITE - OK - 
17, 0,00 s, 1,2, its 2, BCC_A2 CEMENTITE - OK - 
18, 0,00 s, 1,25, its 2, BCC_A2 CEMENTITE - OK - 
19, 0,00 s, 1,3, its 2, BCC_A2 CEMENTITE - OK - 
20, 0,00 s, 1,35, its 2, BCC_A2 CEMENTITE - OK - 
21, 0,00 s, 1,4, its 2, BCC_A2 CEMENTITE - OK - 
22, 0,00 s, 1,45, its 2, BCC_A2 CEMENTITE - OK - 
23, 0,00 s, 1,5, its 2, BCC_A2 CEMENTITE - OK - 
changing step direction ... 
24, 0,00 s, 0,35, its 2, BCC_A2 CEMENTITE - OK - 
25, 0,00 s, 0,3, its 2, BCC_A2 CEMENTITE - OK - 
26, 0,00 s, 0,25, its 2, BCC_A2 CEMENTITE - OK - 
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27, 0,00 s, 0,2, its 2, BCC_A2 CEMENTITE - OK - 
28, 0,00 s, 0,15, its 2, BCC_A2 CEMENTITE - OK - 
29, 0,00 s, 0,1, its 2, BCC_A2 CEMENTITE - OK - 
30, 0,00 s, 0,05, its 2, BCC_A2 CEMENTITE - OK - 
Xsol 'CEMENTITE': X(C): 5,6263874e-005, WP(C): 0.0012101191 - OK - 
31, 0,03 s, 1e-009, its 13, BCC_A2 - OK - 
Steps: 32, CalcTime: 0,75 s 
AktStepVal: 0,000000 
- OK -  
  
Similarly to the temperature-step calculation, the output consists of a series of equilibria evaluated 
at the specified step-values. The first of these corresponds to the carbon content of 0.4 wt.% 
entered in the 'System composition' box in Tutorial 2. The carbon content is then increased in 
0.05 wt.% steps up to the maximum value of 1.5 wt.%. The 'Changing step direction' line marks 
the beginning of the second set of equilibria, in which the carbon content is decreased. 
At 500°C, the stable phases are BCC_A2 and CEMENTITE across almost the whole composition 
range, but between the final two equilibria there is a line beginning with 'Xsol'. The line below this 
gives the carbon content at which cementite becomes unstable, both in mole fraction 'X(C)' and in 
weight percent 'WP(C)'. 
Create a third buffer named 'C=0 to 1.5 at 800°C' and perform a stepped calculation with the 
same composition range but at a temperature of 800°C. The output in this case includes three 
'Xsol' lines, corresponding to changes in phase stability: 
  
1, 0,02 s, 0,4, its 49, FCC_A1 - OK -  
2, 0,00 s, 0,45, its 4, FCC_A1 - OK - 
3, 0,00 s, 0,5, its 3, FCC_A1 - OK - 
4, 0,00 s, 0,55, its 3, FCC_A1 - OK - 
5, 0,00 s, 0,6, its 3, FCC_A1 - OK - 
6, 0,00 s, 0,65, its 3, FCC_A1 - OK - 
7, 0,00 s, 0,7, its 3, FCC_A1 - OK - 
8, 0,00 s, 0,75, its 3, FCC_A1 - OK - 
9, 0,00 s, 0,8, its 3, FCC_A1 - OK - 
10, 0,02 s, 0,85, its 3, FCC_A1 - OK - 
11, 0,00 s, 0,9, its 3, FCC_A1 - OK - 
Xsol 'CEMENTITE': X(C): 0.042626921, WP(C): 0.94851252 - OK - 
12, 0,01 s, 0,95, its 4, FCC_A1 CEMENTITE - OK - 
13, 0,00 s, 1, its 2, FCC_A1 CEMENTITE - OK - 
14, 0,00 s, 1,05, its 2, FCC_A1 CEMENTITE - OK - 
15, 0,00 s, 1,1, its 2, FCC_A1 CEMENTITE - OK - 
16, 0,00 s, 1,15, its 2, FCC_A1 CEMENTITE - OK - 
17, 0,00 s, 1,2, its 2, FCC_A1 CEMENTITE - OK - 
18, 0,00 s, 1,25, its 2, FCC_A1 CEMENTITE - OK - 
19, 0,00 s, 1,3, its 2, FCC_A1 CEMENTITE - OK - 
20, 0,00 s, 1,35, its 2, FCC_A1 CEMENTITE - OK - 
21, 0,00 s, 1,4, its 2, FCC_A1 CEMENTITE - OK - 
22, 0,00 s, 1,45, its 2, FCC_A1 CEMENTITE - OK - 
23, 0,00 s, 1,5, its 2, FCC_A1 CEMENTITE - OK - 
changing step direction ... 
24, 0,00 s, 0,35, its 4, FCC_A1 - OK - 
Xsol 'BCC_A2': X(C): 0.015673104, WP(C): 0.34127957 - OK - 
25, 0,02 s, 0,3, its 4, FCC_A1 BCC_A2 - OK - 
26, 0,00 s, 0,25, its 2, FCC_A1 BCC_A2 - OK - 
27, 0,00 s, 0,2, its 2, FCC_A1 BCC_A2 - OK - 
28, 0,00 s, 0,15, its 2, FCC_A1 BCC_A2 - OK - 
29, 0,00 s, 0,1, its 2, FCC_A1 BCC_A2 - OK - 
30, 0,00 s, 0,05, its 2, FCC_A1 BCC_A2 - OK - 
Xsol 'FCC_A1': X(C): 0.000555891, WP(C): 0.011960753 - OK - 
31, 0,01 s, 1e-009, its 9, BCC_A2 - OK - 
Steps: 32, CalcTime: 0,30 s 
AktStepVal: 0,000000 
- OK -  

Edit buffer states 

The 'Output' window provides information on which phases are stable at a given temperature and 
carbon content, but not on the phase fractions or compositions. However, this detailed information 
is stored in the buffers and can be found by selecting 'Global > Buffers > Edit buffer states'. 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
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The upper part of this window contains a drop-box for selecting a buffer, and the lower part gives a 
list of the step-values at which equilibria have been evaluated. These are either temperature or 
carbon content values, depending on the buffer chosen, and their units are those specified in the 
'Step equilibrium' window when setting up the calculation. The 'Tsol' or 'Xsol' values are also 
stored. If the 'auto load' box at the bottom left is ticked, clicking on a step-value loads the 
equilibrium, and the contents of the 'Phase summary' and 'Phase details' are immediately 
updated with phase fraction and composition details for this equilibrium.  
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The next two tutorials demonstrate how to produce graphical plots of phase fractions, compositions 
and many other quantities as a function of the stepped variable. 

To finish... 

Save the workspace file - it will be needed again in Tutorial 4. 

 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
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T4: Graphical presentation and export of results (1) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents 

• Creating a new graphical window 
• Introduction to the variables window 
• Modifying the appearance of a plot using 'options' 
• Zooming in and displaying x- and y-values 
• Exporting a plot as an image and as numerical data 

Before starting... 

Open the file saved from Tutorial 3 and select the buffer named 'T=400 to 1600°C'. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t4:script:t4.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t3
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1. Plotting a graph 

To plot numerical results, it is first necessary to create a graphical window. In the 'View' menu, 

click on 'Create new window' or click on icon. 
  

 
  
In the 'Create new window' box which appears, there is a list of a number of possible window 
types. Among these are '(a1)', '(a5)' and '(a6)', which are the familiar 'output', 'phase 
summary' and 'phase details' windows automatically placed on the screen when a new 
workspace file is created. 
Select type '(p1) Plot: XY-data' and click on 'OK' 
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An empty plot with x- and y-axes appears on the screen. Locate the 'Variables' window. (If it is 
not present, right-click in the toolbar area at the top of the screen and select it from the menu, or 
click on 'Show variables window' from the 'View' menu.) Expand the 'favorites' section by 
clicking on the small plus-sign to its left. Then, further expand the section labelled 'F$*' to give the 
list shown below. 
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The syntax 'F$BCC_A2' means 'the phase fraction of BCC_A2', where the dollar sign is a 
separator between the variable 'F' and the phase to which it applies 'BCC_A2'. In the heading of 
the list, 'F$*', the asterisk is a wild-card indicating 'all phases'. Select 'F$*', drag it to the empty 
plot and drop it. 
The plot should appear as shown below: 
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2. Changing the appearance of the plot 

Results from different buffers 

The 'Options' window can now be used to modify the appearance of the plot as required. (Again, if 
this is not currently shown, it can be made to appear using the View menu or the right-click menu 
in the toolbar area.) 
  

 
  
Firstly, note that there is a 'buffer' drop-box. By selecting one of the other buffers, the contents of 
the plot can be changed. The 'default x-data' option (the second line down in the options 
window) is set to StepValue, i.e. the value of the stepped variable used in the stepped equilibrium 
calculation. Thus, on selecting the 'C=0 to 1.5 at 500°C' buffer, the x-value changes to carbon 
content, and the plot looks like this: 
  

 
  
and the plot for the 'C=0 to 1.5 at 800°C' buffer looks like this: 
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Changing the format of the temperature-step plot 

Select the 'T=400 to 1600°C' buffer from the buffer drop-box. One of the first things to note is 
that the x-axis data does not run from 400 to 1600; this is because the step value is expressed by 
default in Kelvin rather than in Celsius. To change this, double-click on the 'default x-data' line. A 
box appears, entitled 'New value for 'default x-data''. Enter 'T$C' (temperature in Celsius) in 
place of 'StepValue'. 
  

 
  
The plot can be changed from colour to black-and-white ('b/w') using the 'style sheet' drop box.  
The 'plots' section of the options menu can be expanded using the plus-sign. Below 'plot#0' (the 
name of the current plot) is a list of options for this plot: 
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Title 

This is blank by default. Double-click to enter a title, e.g. 'Phase fraction versus temperature 
for Fe-0.4 wt.%C'. 

Legend  

This comprises options for the position of the legend and for the style of the box surrounding it. 
  

 

Axes 

The 'axes' section expands to give options for the 'x-axis', 'y-axis', '2nd x-axis' and '2nd y-
axis' (the latter two are not used in the current plot). 
  

 
  
Double-clicking on the 'title' line will bring up a box entitled 'New value for title'. Enter 
'Temperature [°C]'. In the same way, change the y-axis title to 'Phase fraction'.  
The axis type can be set to either linear or logarithmic. A linear scale is more suitable for the 
temperature axis, but a logarithmic y-axis enables the fractions of minor phases, such as cementite 
in this example, to be seen more clearly. Change 'lin' to 'log' for the y-axis. 
The automatically assigned minimum y-value on the log-scale may not be appropriate, so if this is 
the case, double-click on 'scaling' and replace 'auto' with '0.01..1'. The two numbers are the 
lower and upper limits respectively. If one or other of these is missed off, an automatic value is 
assigned instead. (For example, using '0.01..' is sufficient to give a scale from 0.01 to 1, since 1 is 
the maximum value of F$*). 

Grid 

This allows gridlines to be added to the plot, and their appearance to be modified. Change 
'disabled' to 'enabled' for 'major-x' and 'major-y' to show major gridlines. 
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Series 

Expanding the 'series' section gives a list of options for each data-series. The name of the series 
(as it appears in the legend) can be changed using 'name'.  
The 'locked' option, when set to 'yes', protects the series from any changes when the contents of 
the buffer are updated. A locked series is indicated by an asterisk by the name, if the automatic 
name is used.  
'Derivative' can be used to display the numerically evaluated first or second derivative of a series. 
The 'x-data' and 'y-data' options control which data-sets are displayed on the x- and y-axes. If 
the 'x-data' is set to 'auto', the default x-data, as specified above, is used. 
The appearance of the plots can be modified by setting 'default style' to 'no' rather than 'yes', 
and then expanding 'line' and 'marker' to give a list of options for colours, styles, sizes etc. 
  

 
  
The image below gives an example of a modified plot. 
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3. Other plot operations 

Zooming areas of the plot  

Left-click in the plot area and drag the mouse to draw a rectangular box. When the mouse button 
is released, an enlarged version of the region within the box is shown on the axes. Right-click 
anywhere in the plot area to return to the original scale. 

Displaying x- and y-values 

When moving the mouse pointer on the plot area, a black cross appears with the y- and x-values 
next to it. The coordinates of the centre of the cross are also shown on the status bar at the 
bottom left of the screen. A larger, red cross can be obtained by pressing the right mouse 
button. 

Exporting data from the plot 

Right-clicking in the plot window but outside the area of the plot itself gives a context menu as 
shown below. 
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Clicking on 'Copy to clipboard' allows to export the plot or the frame (which is a plot with some 
blank space around it) in the pixmap (.bmp) or scalar vector graphics (.svg) format. Then the 
exported piece can be pasted to the relevant graphical application. Additional for the plot, there is 
a possibility to export the numerical data which will appear in the form of tab-separated columns 
after the paste operation.  
Clicking on the 'Export to file' will create the file containing the plot or the frame. The possible 
output file formats are '.png', '.svg' and '.pdf' 
  

To finish... 

Save the workspace file. 
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T5: MatCalc built-in variables; graphical output (2) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents 

• Adding further plots to a plot window 
• Using the built-in variables 
• Defining a default x-axis  
• Modifying the series  
• Adding a new series to a plot  
• Removing a series from a plot  
• Duplicating and locking series  
• Editing series data  
• Converting series to tables 

Before starting... 

Re-open the file saved in Tutorial 4 and save it under a new name. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t5:script:t5.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
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1. Adding plots of different variables 

Creating a new plot 

Highlight the plot window and right-click in this window outside the plot area to bring up the plot 
context menu already seen in Tutorial 4. Click on 'New plot'. 
  

 
  
An empty plot appears below the original one.  

Variables 

As well as the phase fraction variables 'F$*' encountered in the previous tutorial, MatCalc contains 
many other built-in variables which are evaluated at each step-value of the stepped equilibrium 
calculations. These can be found in the variables window. Information about each variable is 
contained in the small window below the main variables window. Locate the 'driving forces' 
category and drag 'DFM$*' to the empty plot window, to give a plot as shown below. 
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Other variable categories of particular interest for stepped equilibrium calculations are highlighted 
in blue in the image below: 
  

 

- 'favorites' 

This contains the most frequently needed variables: temperature in Kelvin ('T') and in Celsius 
('T$C'), step-value, phase fractions ('F$*') and compositions expressed in mole fraction ('X$*$*') 
and in weight percent ('X$*$*$wp'). In these composition variables, the first asterisk represents 
the phase, and the second, the element, for example 'X$LIQUID$C'. 

- 'general' 

Temperature, step-value and pressure can also be found under this category. The temperature is in 
Kelvin by default, but the temperature in Celsius can be obtained by appending '$C', as has 
already been seen in the 'Favorites' category. This suffix is known as a 'unit qualifier'. The 
'information on variables' window shows the valid unit qualifiers for the variables: 
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- 'phase fractions' 

The phase fractions 'F$*' are repeated here. 

- 'composition' 

This contains the 'X$*$*' composition variables mentioned above, and a number of other 
composition-related variables, expressed either as either mole fractions (X...) or as u-fractions 
(U...). (Not all of these are applicable to stepped-equilibrium calculations, however: 'XP$*$*' and 
'UP$*$*' are for precipitation calculations.)  
Compositions in weight percent are not given separately here, but it can be seen from the 
'variables information' window that 'wp' is a valid unit qualifier for the variables beginning with 
'X'. This means that weight percentages can be obtained by appending '$wp' to the names of 
these variables.  

- 'site fractions' 

The 'Y$*$*$*' variables give the site fraction of an element on a particular sublattice of a phase. 
For example, BCC_A2 has the variables 'Y$BCC_A2$FE$0' (site fraction of iron on sublattice 0) 
and 'Y$BCC_A2$C$1' (site fractions of carbon and vacancies on sublattice 1). The 'YX$*$*' 
variables represent the mole fraction of an element on a particular sublattice position of a phase; in 
this case, vacancies are not considered. 

- 'state variables' 

This category consists of a number of thermodynamic variables, including molar Gibbs free 
energies, entropies, enthalpies and heat capacities of the system and of each phase. 

- 'chemical potentials', 'activities' 

These categories include chemical potentials 'MU$*$*', activities 'AC$*$*' and activity 
coefficients 'ACC$*$*'.  
Further plots can be added to the same plot window using 'New plot'; they will share the same 
buffer, default x-data and colour scheme. Some examples are shown below: 
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- Molar Gibbs free energy ('GMP$*') 
  

 
  
- Chemical potential of carbon ('MUP$*$C') - here, the chemical potential of carbon in the 
cementite phase was omitted (the scale of y-axis is limited to +10.000) 
  

 
  
- Molar heat capacity ('CPP$*', note the lambda-anomaly at the Curie temperature in BCC_A2) 
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Arranging plots in the columns 

When there are many plots in the plot window then they will get streched so much that they will 
eventually become unreadable. In order to obtain a transparency, it might be a good idea to 
arrange the plots in more than one column. To place the plots in two columns, click on 'plot 
columns' in 'Options' window and type '2' in the appearing dialog. 
  

 

Default x-axis 

To give a consistent appearance to all the x-axes in the plot window, a 'default x-axis' can be 
defined. This is found towards the top of the 'Options' window. Change 'no' to 'yes' in the 'use 
for all plots' line and define the properties of the x-axis in the same way as for a normal x-axis. 
  

 

Displaying x-values of multiple plots 

If the plot window contains several plots, right-clicking and dragging the mouse in one of these will 
display not only a cross in that plot, but a vertical line at the same x-value in all the others. An 
example is shown below: 
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2. Modifying the series in a plot 

This part of the tutorial will demonstrate how to use the unit qualifiers mentioned above. Add a 
new plot to the plot window and drag and drop 'X$*$C' (carbon content of the phases) from the 
'variables' window. The resulting plot should look like this: 
  

 
  
By default, the carbon content is expressed in mole fraction. To change the units to weight percent, 
firstly click on the new plot to select it. This should expand the section of the 'Options' list which 
applies to the new plot. Click on the plus-sign by 'series' to open the series options: 
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Double-click on 'y-data' for the first series to open the following box. Append '$wp' to the existing 
expression and click 'OK'. 
  

 
  
This will change the values plotted for the 'LIQUID' series. Repeat for the other three series. The 
final appearance of the plot, with appropriate axis labels added, should be as shown below. 
  

 
  

3. Other series operations 

Right-clicking in the 'Options' window displays a context menu: 
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- 'New series' 
  
The 'New series' part of the menu expands to give the following sub-menu. 
  

 
  
Clicking on 'Buffer results' creates an empty series (given the name of 'auto' on the plot) to 
contain variables evaluated from the results of a buffer. Edit the 'y-data' line in the 'Options' 
window for this series to enter any valid built-in or user-defined variable or an expression.  
Variables can be copied from the 'Variables' window by right-clicking on the expression required 
to display a menu containing Copy, Paste and other operations. 
  

 
  
The other series types which can be added are as follows: 
'Table/experimental data': allows the user to add a set of experimental data points to a plot. 
'Function/expression': enables an algebraic expression in (x) to be entered. 

- 'Remove series', 'Remove all series', 'Remove all locked series' 

To remove a series from a plot, first click on the plot to select it. This will expand the part of the 
Options list which applies to the plot. Select the name of the series from this list and choose 
'Remove series' from the right-click menu (shown above) or press 'Delete'. Multiple series in the 
same plot can be selected at once by holding down the CTRL key while clicking on the series 
names. 'Remove all series' in the right-click menu deletes all the series in the selected plot. 
'Remove all locked series' removes all the series which are locked (locking the series is 
described below). 

- 'Duplicate and lock series ...', 'Duplicate and lock all series' 

This feature is available in the right-click menus of both the Options window and the plot window. 
Select a series from the list shown and click on 'Duplicate'. This will lock the original series and 
create a copy. 'Duplicate and lock all series' performs this for all series in the selected plot. 
The locked series is protected from any changes when the buffer contents are updated with new 
calculation results, but the copy is unlocked. This enables easy comparison between results 
obtained under different conditions.  
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- 'Edit series data ...' 

This is also available in both the Options and the plot windows. Select a series and click on 'Edit...' 
to display a table containing the numerical data used to plot the graph. 
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The data can be copied using the 'Copy selection' or 'Copy all' buttons. The contents of the rows 
and columns can be modified using 'Paste' (to add data copied from another source), 'Clear 
cell(s)', 'Insert row', 'Insert col' and 'Delete rows/cols' buttons. Use 'Write' to save the 
whole dataset to a text file and 'Read' to load a dataset from a text file. With 'Export' button, a 
text file containing the data separated in two columns can be created. 

- 'Convert series to table' 

This places the data from the series into a named table, which can be accessed from the 'Global' 
menu.  
Select the series, click on 'Convert' and edit the name of the table, if necessary, in the box which 
appears, as shown below. 
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To open and edit a table, select 'Tables...' from the 'Global' menu. This will display a list of all the 
available tables, which can be edited in the same way as the series data described above. 
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T6: Introduction to user-defined functions and variables 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents 

• Expressions using built-in variables 
• Creating a new function  
• Using functions  
• Defining and using variables  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t6:script:t6.mcs
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1. Setting up the system  

Define a system containing the elements Fe and C and and phases LIQUID, FCC_A1, BCC_A2 
and CEMENTITE. Enter the composition 0.1 wt.% C. Make a stepped equilibrium calculation, 
varying the temperature from 400 to 1600°C in 25-degree intervals. 
Create a new plot window and drag and drop 'F$*' from the 'Variables' window into the plot. 
Create a second plot in the same window. Set the 'default x-data' in the Options window to 
'T$C', and define a default x-axis labelled 'Temperature [°C]'.  

2. Combining built-in variables in new expressions 

In systems consisting of a matrix and carbides, it may be interesting to determine how much of the 
carbon in the system is present in the form of carbides, and how much remains in the matrix 
phase(s), at any given temperature. 
The phase fraction 'F$*' represents the number of moles of phase per mole of system, and the 
carbon content of a phase 'X$*$C' represents the number of moles of carbon per mole of phase. 
The product of these quantities for a given phase gives the number of moles of carbon in the 
phase.  
To plot this, first drag 'X$*$C' to the new plot to give the carbon content of each phase. Then go 
to the 'variables' window, select 'F$LIQUID' and copy it using the right-click menu. 
Click on the lower plot, and in the 'Options' window, edit the 'y-data' line for the first series 
('series #0') of this plot. This should currently read 'X$LIQUID$C'. Append '*F$LIQUID' to this. 
Repeat this process for the other series to give 'X$BCC_A2$C*F$BCC_A2', 
'X$FCC_A1$C*F$FCC_A1' and 'X$CEMENTITE$C*F$CEMENTITE'. Add another variable to the 
plot: 'XS$C' (can be found in the 'composition' section), the mole fraction of carbon in the 
system. This should be equal to the sum of the other four variables on the plot. 
The final plot is shown below: 
  

 

3. Defining functions 

Creating a new function 

If the expressions such as 'X$BCC_A2$C*F$BCC_A2' are likely to be used more than once, they 
can be defined as functions. Select 'Global > Variables & Functions'. This brings up a box 
containing several tabs; click on 'Functions'. 
Click on 'New' and type in a name for the function in the box which appears, for example, 
'C_in_liquid'. In the 'Expression' box, type in 'X$LIQUID$C*F$LIQUID'. For convenience, this 
can be copied from the 'y-data' line in the 'Options' window of the plot just finished. (N.B. There 
is no need to put an '=' sign at the beginning of the expression.) Click on 'Set' to register 
the expression. Repeat for the three other expressions plotted above. 
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Close the 'Functions & Variables' box to return to the main screen. Expand 'functions' in the 
'Variables' window by clicking on the small plus-sign to the left of the word. This should give a list 
of the new functions: 
  

 
  
Make a new plot and drag and drop the functions just defined into it to check that this gives the 
same appearance as the plot above. 

New expressions using existing functions 

The fraction of the total carbon content in the system which is in the liquid phase can be calculated 
by dividing the function 'C_in_liquid' by the total carbon content XS$C. Re-open the 'Functions 
& Variables' tab and create a new function named 'Fraction_C_in_liquid'. Enter 
'C_in_liquid/XS$C' in the 'Expression' box and click on 'Set'. Repeat for the other three 
phases. 
On returning to the main screen, create a new plot and drag and drop the new 'Fraction_C_in...' 
functions into it. (This may necessitate clicking on the 'minus' sign by the side of 'Functions' then 
clicking on the 'plus' again to re-open it with the new functions displayed.) The resulting plot 
should have the same appearance as the two plots above, but a different y-scale, this time going 
from 0 to 1. 
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The user-defined functions are saved in the workspace and can be used for all subsequent 
calculations in that workspace.  
Change the 'default x-data' in the Options window to 'StepValue', and the name of the default 
x-axis to 'C content [wt.%]'. Make a new stepped calculation in the '_default_' buffer, varying 
the carbon content from 0 to 0.5 wt.% (with 0.005 step) at 1475°C . 
The phase fraction curve below shows that the carbon content has a strong influence on phase 
stability at this temperature. Increasing the carbon content stabilises FCC_A1 at the expense of 
BCC_A2, and then at higher carbon contents the liquid phase also becomes stable. 
  

 
  
The two sets of user-defined functions appear as shown below, and in this case they provide 
different ways to illustrate the results. 
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4. User-defined variables 

The final part of this tutorial demonstrates the use of the 'Variables' tab under 'Global > 
Variables & Functions'. 
In the plot of C_in_liquid, C_in_bcc, etc., the curves are made up of almost straight-line sections, 
so it should be possible to find analytical expressions of the form y = ax +b for these, where 'a' is 
the gradient and 'b' the intercept on the y-axis. 
The C_in_liquid line starting from around 0.28 wt.% C will be used as an example. To find an 
equation for this line, two (x, y) values on the line are needed. For the first of these, y=0 can be 
used. To find the exact x-value at which the liquid phase fraction is zero, look at the 'Output' 
window which contains now the equilibrium phases present in the system for various carbon 
contents. The line starting with 'Xsol 'LIQUID' shows the LIQUID zero-phase boundary at 1475°C 
in terms of carbon content. 
  
36, 0,00 s, 0,275, its 3, FCC_A1 - OK -  
Xsol 'LIQUID': X(C): 0.012799895, WP(C): 0.2780809 - OK - 
37, 0,02 s, 0,28, its 4, LIQUID FCC_A1 - OK -  
  
The first (x, y) pair is therefore (0.27808158, 0). Go to 'Global > Variables & Functions' and 
select the 'Variables' tab. The variable 'x' is already shown in the left-hand column. This is the 
StepValue, and currently has a value of 0.5. 
Click on 'New' and in the box, type in 'x1'. Select it (in the 'Available items' box) and type in or 
paste the first x-value (0.27808158) in the 'Expression' box (confirmed by clicking on 'Set'). Add 
another variable 'y1'. This has a default value of zero, which does not need to be changed. 
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The second (x, y) pair can be obtained by finding the y-value at x=0.5. Either use edit the buffer 
state for this composition ('Global > Buffers > Edit buffer state', click on '0,5' in the 'Buffer' 
box) or simply set the composition to 0.5 wt.% C and calculate an equilibrium. In both cases, the 
value of 'C_in_liquid' at this composition can be seen in the 'Variables' window. Go to 'View > 
Create New Window' and choose 'd1: List variable'. Drag and drop 'C_in_liquid' from the 
'Variables' window into the new 'List variables' window which appears. 
   
C_in_liquid +1.536687315775e-002 
  
The numerical value can be selected and copied from this window. Re-open the 'Variables' tab and 
add the new variables 'x2' and 'y2', equal to 0.5 and 1.536687315774e-002 respectively. 
The slope m and intercept c of the straight line can now be entered; a is equal to (y2-y1)/(x2-
x1) and b to ((x2*y1)-(x1*y2))/(x2-x1). Create a new variable named 'a', type in the formula 
(or try to copy it from this tutorial) and click on 'Set'. This evaluates the expression and places the 
numerical value in the 'Expressions' box in the place of the formula. Do the same for 'b'. In the 
'Functions' tab, the equation of the line can now be entered. Create a new function 'Liquid_line' 
and type '(a*x)+b' into the 'expression' box. Click 'Close' to return to the main screen.  
Drag the new 'Liquid_line' function from the 'Variables' window to the plot of 'C_in_liquid', etc. 
The resulting plot should look like this: 
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The 'Liquid_line' function extends to negative values, unlike the true C_in_liquid curve, which has 
a value of zero for carbon contents between zero and 0.27 wt.%.  
One way of removing the unwanted part of this line is to select 'Edit series data' from the right-
click menu. In the resulting table, select all the rows for which the y-value is negative and then 
click on 'Delete rows/cols' to remove them. Accept the warning with 'OK'. 
An alternative way is to add the series as a 'function/expression' rather than as a 'buffer 
result'. There are differences in the way the program treats these two types of series; for 
example, in a 'function/expression' series, x-values are specified as a numerical range, and the 
y-values are functions of x, whereas for 'buffer results', the x-values are specified as a variable 
(by default, the StepValue), and the y-values as another variable.  
When a variable is dragged and dropped from the 'variables' window, it automatically becomes a 
'buffer result'-type series. To add a 'function/expression' series, click on the plot, then in the 
options window, select 'new series' from the right-click menu, and choose 
'function/expression'. By 'y-data' for the new series, type in 'Liquid_line'. Edit the 'x-data' 
line to type 'x1..0.5'. 
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The plot should now look as shown in the image below (with the 'Liquid_line' series highlighted). 
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T7: Calculating phase boundaries 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents 

• Using "Search phase boundary" with temperature variation to determine solidus and 
liquidus 

• Determining austenite <-> ferrite transformation temperatures  
• Finding phase boundaries for carbide phases in terms of temperature and element content  
• Tracing a phase boundary on axes of temperature versus element content  

It was seen in Tutorial 3 that MatCalc evaluates solubility temperatures (Tsol) or compositions 
(Xsol) during the course of stepped equilibrium calculations. It is also possible to calculate these 
individually using the 'Search phase boundary' function. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t7:script:t7.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t3
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1. Setting up the system 

Create a new workspace file and set up the system with elements Fe, C and Nb and phases 
FCC_A1, BCC_A2, LIQUID and CEMENTITE. Enter the composition as 0.1 wt.%C, 0.3 wt.% 
Nb and calculate an equilibrium at 1000°C (Refer to Tutorial 1 and Tutorial 2 if necessary.) 
Note the results in the 'Phase details' window. A second FCC_A1 phase has automatically been 
created, and examination of its composition shows that its approximate formula is NbC.  
  
#### /FCC_A1/ moles: 0.99669, gm: -62332.5 (-62332.5), sff: 0.996959  
Phasestatus: entered - active 
FE +9.96862e-001 C +3.04146e-003 NB +9.65336e-005  
#### /FCC_A1#01/ moles: 0.00331011, gm: -112964 (-112964), sff: 0.514554 
Phasestatus: entered - active 
NB +5.14395e-001 C +4.85446e-001 FE +1.59075e-004  
### inactive ### 
#### /BCC_A2/ moles: 0, gm: -62262.4 (-62262.4), sff: 0.999701 
Phasestatus: entered - not active (dfm=-82.83) 
FE +9.99572e-001 C +2.99142e-004 NB +1.28377e-004  
#### /LIQUID/ moles: 0, gm: -58601.3 (-58601.3), sff: 1 
Phasestatus: entered - not active (dfm=-3777) 
FE +9.75342e-001 C +2.34127e-002 NB +1.24518e-003  
#### /CEMENTITE/ moles: 0, gm: -52390.6 (41804.9), sff: 0.25 
Phasestatus: entered - not active (dfm=-9077) 
FE +7.50000e-001 C +2.50000e-001 NB +6.86915e-008  
  
It is the following line in the database file mc_sample_fe.tdb which causes the second FCC_A1 
phase to be created: 
  
ADD_COMPOSITION_SET FCC_A1 :TI,NB,V:C,N: ! 
  
This creates that a new phase of type FCC_A1 with Ti, Nb or V as the major constituents on the 
first sublattice and C or N as the major constituents on the second when the system contains these 
elements. The 'General' tab in the 'Phase status' box ('Global > Phase status') shows the 
major constituents for each phase, :FE:VA: and :NB:C: respectively for FCC_A1 and FCC_A1#01. 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t1
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
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2. Calculating phase boundaries 

Solidus and liquidus temperatures 

The solidus temperature is defined by zero phase fraction of liquid. To calculate this, choose 

'Search phase boundary' from the 'Calc' menu or click on the icon. The box below appears. 
Select 'Temperature' in the left-hand column and 'LIQUID' in the 'Target phase' column, then 
click on 'Go'. 
  

 
  
The following message appears in the output window. 
  
Tsol 'LIQUID': 1480.30 C (1753.46 K) iter: 16, time used: 0.02 s 
  
The liquidus temperature is the dissolution temperature of the last solid phase, which in this case is 
BCC_A2. Selecting 'BCC_A2' as the target phase gives the following result: 
  
Tsol 'BCC_A2': 1452.43 C (1725.59 K) iter: 5, time used: 0.00 s 
  
Of course, this is not a liquidus temperature, as it cannot be lower than the solidus temperature. 
This result is given because MatCalc finds the zero phase fraction temperature of BCC_A2 phase 
next to the temperature of the last calculation which is 1480.30°C in this case (the liquidus 
temperature). Information given in 'Phase summary' window explains that at 1452.43°C, 
BCC_A2 appears next to FCC_A1 phase (inactive BCC_A2 phase has the driving force value of 
zero). It is recommended to look at the 'Phase summary' window in order to check if the 
found phase boundary is the desired one! 
The liquidus phase can be easily found if an equilibrium calculation in the liquid system is 
performed first. Calculate an equlibrium at 1600°C (or any temperature in which system contains 
only a liquid) and search again for the phase boundary of BCC_A2 phase. This time the following 
result should be given: 
  
Tsol 'BCC_A2': 1527,33 C (1800,49 K) iter: 4, time used: 0,03 s 
  
In general, the correct phase boundaries are found if the initial equilibrium describes the 
system in the neighbouring phase field which does not contain the searched phase - in 
the case presented above, the liquidus temperature (which is the border between the 
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"BCC+LIQUID" and "LIQUID" phases) was found from the "LIQUID" phase field. Also, the algorithm 
used to search for phase boundaries might fail to converge if the starting point is too far away from 
the boundary. 

Austenite-ferrite transformation temperatures 

Low-alloy steels undergo a ferrite - austenite phase transformation between 700 and 800°C (see, 
for example, Tutorial 4). To find the exact temperatures of the transformation in the Fe-0.1wt.%C-
0.3wt.%Nb system, calculate an equilibrium at 700°C and use again 'Search phase boundary'. 
Select 'FCC_A1' as a target phase to identify the zero-phase boundary temperature for austenite.  
  
Tsol 'FCC_A1': 726.62 C (999.78 K) iter: 11, time used: 0.00 s 
  
The zero-phase boundary of BCC_A2 for this transformation can be identified by calculating an 
equilibrium at 900°C and then searching for the boundary. 
  
Tsol 'BCC_A2': 883,07 C (1156,23 K) iter: 5, time used: 0,05 s 

Dissolution temperatures of carbides 

Cementite is only stable to relatively low temperatures, so calculate an equilibrium at 800°C as a 
starting point, then search for the phase boundary. 
  
Tsol 'CEMENTITE': 726,62 C (999,78 K) iter: 9, time used: 0,05 s 
  
Note that this is the same temperature as the zero-phase boundary of FCC_A1. Niobium carbide, 
by contrast, remains stable at higher temperatures. Calculate an equilibrium at 1200°C before 
searching for the boundary. 
  
Tsol 'FCC_A1#01': 1346.00 C (1619.16 K) iter: 5, time used: 0.00 s 

Element content for zero-phase fractions 

Phase boundaries can also be found in terms of element content at a fixed temperature. To 
illustrate this, the zero-phase boundary of cementite at 700°C will be evaluated in terms of carbon 
content. Calculate an equilibrium at 700°C, then open the 'Search phase boundary' box and 
select 'Element content' in the left-hand column. Set the target phase to 'CEMENTITE', the 
element to be varied to 'C', and the temperature to '700', then click 'Go'. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
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The output gives the carbon content for zero phase fraction of cementite in mole fraction and in 
weight percent. 
  
iter: 2, time used: 0.00 s, GibbsEnergy: -40682.343 J  
X(C): 0.0024577437, WP(C): 0.052897424, T: 700 C (973.16 K) - OK -  
  
Note: After the search for the phase boundary with element content variation, the 
composition of the system is changed to the found value! (check 'Global > Composition') 
   
In the same way, the zero phase fraction boundary for niobium carbide at 1000°C can be evaluated 
in terms of the niobium content. Firstly, open 'Global > Composition' and reset the carbon 
content to 0.1 wt.%. Calculate an equilibrium at 1000°C, then search for the phase boundary for 
'FCC_A1#01', this time setting the element to be varied to 'Nb'.  
  
iter: 7, time used: 0.02 s, GibbsEnergy: -62319.956 J  
X(NB): 6.653432e-005, WP(NB): 0.011108476, T: 1000 C (1273.16 K) - OK -  

Tracing phase boundaries 

Once a point on a phase boundary has been identified using the process described above, the 
boundary can be traced as a function of element content. In the following example, the effect of 
the niobium content on the temperature of the FCC_A1#01 (NbC) zero-phase boundary will be 
calculated. 
Firstly, reset the composition to 0.1 wt.% C, 0.3 wt.% Nb. Calculate an equilibrium at 1000°C, 
then search for the temperature of the FCC_A1#01 zero-phase boundary. Having established this 
point on the boundary, open the 'Step equilibrium' window using 'Calc > Stepped calculation' 
and select 'Phase boundary' from the left-hand column. 
In the 'Boundary conditions' box, set the element to 'Nb', the target phase to 'FCC_A1#01' 
and the max. T-step to '100'. (The use of this parameter will be discussed in Tutorial 8.) Enter 
'0.01', '0.6' and '0.01' as the start, stop and step interval values in the 'Range' box. Click on 
'Go' to perform the calculation 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t8
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Create a new X-Y plot window (Tutorial 4) and drag and drop 'T$c' into it. The plot should look like 
this: 
  

 
  
Right-click in the plot window outside the plot area and choose 'Duplicate and lock series' from 
the window (see Tutorial 5). Double-click on the name of the series to duplicate it. In the 
'Options' window, change the name of the original series ('*_T$c') to '0.1 wt.%C'. 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
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Change the carbon content of the system to 0.05 wt.% C, calculate an equilibrium at 1000°C and 
search for the phase boundary, then make a stepped calculation using the same conditions as 
before. The phase boundary for 0.05 wt.% C should follow the green curve in the plot below, which 
also shows the same phase boundary for 0.01 wt.%C. 
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T8: Calculating a phase diagram in a binary system 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  
  
This tutorial introduces the calculation of phase diagrams with an example featuring the well-
known Fe-C binary system.  

Contents: 

• Calculating phase boundaries 
• Building up the phase diagram from the calculated boundaries  
• Choosing appropriate calculation parameters  
• Phase diagrams using stable and metastable equilibria  

A phase diagram consists of a number of phase-boundaries separating regions of temperature- and 
composition-space in which different phases are stable at equilibrium. Published equilibrium 
diagrams for the Fe-C system often show equilibria between Fe-rich phases and both C (in the form 
of graphite) and cementite (Fe3C). Graphite is the more stable of these two phases, and forms 
readily in cast irons (2-4 wt.% C), but usually with great difficulty in steels (up to 1.5 wt.% C). In 
the latter, it is more practically useful to consider metastable equilibria involving Fe3C. In this 
tutorial, phase diagrams for both Fe-C and Fe-Fe3C will be calculated. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t8:script:t8.mcs
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1. Setting up the system 

Create a new workspace file. From the 'mc_sample_fe.tdb' database, select the elements FE and 
C and the phases LIQUID, BCC_A2, FCC_A1, CEMENTITE and GRAPHITE. Enter the composition 
0.05 wt.% C. Create a new plot window of type p1 (X-Y data). 
The phase diagrams will be calculated from 0 to 5 wt.% C, but the low carbon content of 0.05 
wt.% C is chosen so that the lines bounding the high-temperature ('delta') ferrite phase, which is 
only stable at relatively low carbon contents, can be found. 
Firstly, the Fe-Fe3C diagram will be calculated, so it is necessary to suspend graphite, since it is 
more stable than Fe3C. Open 'Global > Phase status'. In the 'General' tab, put a tick-mark in 
the box beside 'suspended': 
  

 



Tutorial 8 

 66

2. Fe-Fe3C phase diagram 

The phase diagram is made up of a number of phase boundaries. As was have seen in the last part 
of Tutorial 7, these boundaries can be found by finding a point on the boundary, then tracing the 
boundary as a function of element content. The method for tracing a boundary for phase 'X' is as 
follows: 

1. Calculate an equilibrium at an appropriate temperature, near to the expected boundary 
temperature 

2. Find the 'X'-phase boundary by varying the temperature with 'X' as the target phase  
3. Perform a stepped calculation, varying the element content between selected limits, with 

'X' as the target phase  

Upper boundary of delta-ferrite, BCC_A2 

Beginning at the high-temperature end of the diagram, the uppermost phase boundary at a 
composition of 0.05 wt.% C is between a single-phase liquid region and a liquid and delta-ferrite 
(BCC_A2) region. The first boundary which must be found is, therefore, a BCC_A2 phase boundary.  
To locate the boundary, an equilibrium must first be calculated reasonably close to the expected 
boundary temperature. It can be seen that the line lies somewhere between 1538°C (the melting 

temperature of pure iron) and 1500°C. Click on the icon and enter the temperature '1530'. (If 
this gives an error message, select 'Calc > Set start values' then repeat the equilibrium 

calculation.) Then click on to open the 'Search phase boundary' window. Select 
'Temperature' in the left-hand column and 'BCC_A2' as the target phase. The 'Output' window 
should show the following message: 
  
Tsol 'BCC_A2': 1533.98 C (1807.14 K) iter: 4, time used: 0.00 s 
  
This shows that a point on the boundary has been found successfully. The next step is to trace this 

boundary using the stepped equilibrium function to vary the carbon content. Click on and 
choose 'Phase boundary' from the left-hand column. Enter the range: '0' to '5', in intervals of 
'0.01'. Select 'C' as the varying element and 'BCC_A2' as the target phase. Leave the 'Max T-
step' value at its default value of '20'. In the 'Options' section of this window, check that 
'Temperature in Celsius' and 'Composition in weight percent' are both selected. Click on 'Go' 
to launch the calculation. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t7
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The following message appears ; accept it with 'Yes'.  
  

 
  
Now that the first phase boundary has been calculated, drag and drop 'T$C' from the 'Variables' 
window (where it can be found under 'favorites') to the plot. It is useful to add gridlines to the 
plot. Note that the x-axis currently only runs from zero to just over 0.5 wt.% C. From the point 
identified on the phase boundary, the calculation first proceeds in a direction of increasing carbon 
content. However, the BCC_A2 phase is not stable beyond approx 0.53 wt.% C, so the calculation 
(which cannot reach the stop limit of 5 wt.% C) stops and the 'Continue in other direction?' 
message shown above is displayed to ask whether the user wishes to complete the rest of the 
calculation, in which the carbon content is decreased from the point identified at 0.05 wt.% C to 
zero. 
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Right-click in the plot window outside the plot area itself, and select 'Duplicate and lock series' 
from the menu displayed. Select the name of the series and click 'Duplicate' to produce a copy of 
the series. In the 'options' window, rename the first series 'bcc_high_1'. 

Lower boundary of liquid 

The next phase boundary encountered on decreasing the temperature is between the LIQUID + 
BCC_A2 region and the BCC_A2 single-phase region, so this is a LIQUID-phase boundary. 1500°C 
would appear to be a suitable temperature for the starting equilibrium to find this line. In the 
'search phase boundary' box, select 'LIQUID'. The following line of output should appear: 
  
Tsol 'LIQUID': 1515.43 C (1788.59 K) iter: 4, time used: 0.00 s 
  
Then make a stepped calculation with the same start, stop and interval values and the target phase 
set to 'LIQUID'. (A start-value of zero is automatically changed by the program to '1e-9' to 
facilitate the calculation.) The diagram should now look like this: 
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Lower boundary of delta-ferrite (BCC_A2) 

Calculate an equilibrium at 1400°C, search for BCC_A2, step from 0 to 5 wt.% C with an interval of 
0.01 wt.% C. Accept the 'Continue in other direction' message (the calculation could not reach 
5 wt.% C limit, again) with 'Yes'. The boundary temperature should be 1429.60 C (1702.76 K). 

Upper boundary of austenite (gamma, FCC_A1) 

Calculate an equilibrium at 1500°C, search for FCC_A1, step from 0 to 5 wt.% C with an interval of 
0.01 wt.% C. The boundary temperature should be 1460.18 C (1733.34 K). 

Upper boundary of low-temperature ('alpha') ferrite, BCC_A2 

Calculate an equilibrium at 900°C, search for BCC_A2, step from 0 to 5 wt.% C with an interval of 
0.01 wt.% C. The boundary temperature should be 888.64 C (1161.80 K). The image below shows 
how the diagram should look, with appropriate labels for the lines: 
  

 
  
The most of the upper section is now done, with the exception of the phase boundary between 
LIQUID and LIQUID + CEMENTITE for hypereutectic compositions. This line is continuous with the 
cementite line between the FCC_A1 and FCC_A1 + CEMENTITE regions and the horizontal line 
between BCC_A2 + FCC_A1 and BCC_A2 + CEMENTITE regions, so it will appear when this line is 
calculated. 
In the lower section, there is a very narrow alpha-ferrite single-phase region at low carbon 
contents. The upper part of this region is bounded by an FCC_A1 boundary, and the lower part of 
the region by a CEMENTITE boundary. Since these two boundaries are very steep, it is necessary to 
modify the calculation parameters. Failure to do this can lead to incorrectly calculated boundaries, 
as shown in the diagram below (an attempt to calculate the FCC_A1 line using the parameters used 
so far). 
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Lower boundary of austenite (gamma, FCC_A1) 

Calculate an equilibrium at 700°C then search for the FCC_A1 phase boundary, which should be at 
726.62°C. Step from 0 to 5, with an increment of 0.001 instead of 0.01. This reduced increment 
makes the calculation rather more time-consuming; on a slow machine, it may be better to divide 
it into two parts: step from 0 to 0.02 with an increment of 0.001, duplicate and lock, step from 
0.02 to 5 with an increment of 0.01.  

Upper boundary of cementite 

Calculate an equilibrium at 800°C. Search for the CEMENTITE phase boundary; this also should be 
at 726.62°C. Using the same settings as for the previous stepped calculation, the phase boundary 
is calculated correctly, but extends in the negative temperature direction beyond physically 
reasonable values. This occurs because the calculated boundary becomes increasingly steep as the 
carbon content approaches zero.  
One way of removing the unwanted line portion is simply to modify the scaling of the y-axis. (The 
minimum temperatures given on equilibrium diagrams are typically 400-500°C, because it 
becomes difficult to attain equilibrium over practical timescales at low temperatures.) Another 
solution is to remove unwanted data points using 'Edit series data' from the right-click menu of the 
plot.  
Alternatively, the 'overshoot' can be avoided by modifying the parameters of the stepped 
calculation. Increasing the 'max T-step' allows greater steps in temperature, enabling the 
program to cope with very steep boundaries. A suitable value is 100 or 200. Additionally, setting 
the starting value of the stepped calculation to a slightly higher value, for example 0.0005 instead 
of 1e-9, avoids the calculation of the steepest parts of the phase boundary. With these modified 
settings, a satisfactory appearance is obtained without the need to change the axis scalings or 
delete any points.  
  

A few words on the 'max. T-step' parameter 

Following a phase boundary in the stepped calculation is performed by a simple procedure. Once an 
initial point is found with 'Search phase boundary' operation, the composition of the system is 
changed by a value specified as a step in the 'Range' section of 'Stepped equilibrium' window. 
For this new composition, MatCalc search a phase boundary in a temperature range (Told - 'max T-
step' ; Told + 'max T-step'), where Told is a temperature of a phase boundary at a previous 
composition. If the phase boundary is too steep, no phase boundary would be found. In such a 
case MatCalc changes a variable from the element content to the temperature (this is indicated by 
the message 'changing independent variable to temperature' in the 'Output' window). In 
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effect, the temperature will be varied by a step equal to the value of 'max T-step' parameter and 
MatCalc will look for the phase boundary at that temperature. In some cases, this might result with 
the wrong equilibria, especially when the stoichiometric compounds are the equlibrium phases (due 
to the undefined chemical potentials for these phases) 

The finished diagram 

Do not forget to lock the last series to be added, so that it is not modified when another calculation 
is performed. Add axis labels and a title 'Fe-Fe3C phase diagram'. The subscript can be obtained 
using HTML tags:  
  
Fe-Fe<sub>3</sub>C phase diagram 
  
The finished phase diagram should look like this; compare with the sketch below to verify that all 
the lines have been calculated correctly. 
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The image below shows an expanded version of the low-C region. 
  

 

3. Fe-C phase diagram 

Set up this system by removing the 'suspended' flag for GRAPHITE under 'Global > Phase status 
> General'. 
The calculation of the Fe-C diagram is left as an exercise to allow the user to familiarise him- or 
herself with the method, including the choice of appropriate values for the starting equilibrium 
calculation temperatures and the calculation parameters. However, suggestions are given at the 
foot of the page. The diagram below shows how the finished diagram should look. (Alternatively, 
the phase boundaries from the Fe-C calculations can be superposed on the Fe-Fe3C phase diagram 
for comparison.) 
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Suggested parameters for calculation of Fe-C phase diagram 

1. Upper boundary of high-T bcc: Equilibrium at 1550°C (Tsol 'BCC_A2': 1533.98°C); step 
from 0 to 5 with interval of 0.01, max T-step 20 

2. Lower boundary of liquid: Equilibrium at 1500°C (Tsol 'LIQUID': 1515.43°C); step with 
same parameters  

3. Lower boundary of high-T bcc: Equilibrium at 1400°C (Tsol 'BCC_A2': 1429.60°C); 
same parameters  

4. Upper boundary of fcc: Equilibrium at 1500°C (Tsol 'FCC_A1': 1460.18°C); same 
parameters  

5. Upper boundary of low-T bcc: Equilibrium at 900°C (Tsol 'BCC_A2': 888.64°C); same 
parameters  

6. Lower boundary of fcc: Equilibrium at 700°C (Tsol 'FCC_A1': 738.02°C). For this line, 
the parameters must be modified: decrease the interval to 0.001 or increase the T-step to 
200. The latter solution (an interval of 0.01 and a T-step of 200) is acceptable because this 
boundary is a straight line so is correctly defined despite there being only a few points in 
this region. An error message (max no of iterations reached) may appear, but the line is 
calculated successfully.  

7. Upper boundary of graphite: Equilibrium at 800°C (Tsol 'GRAPHITE': 738.02°C). In this 
case, the boundary is curved, so it is advisable to decrease the interval to 0.001 as well as 
increasing the T-step to 100 to obtain better resolution of the curvature. This boundary, 
like the cementite boundary discussed above, tends to 'overshoot' to very low temperature 
values. This can be prevented by setting the minimum carbon content for the stepped 
calculation to 0.0005 instead of 1e-9. 
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T9: Calculating pseudobinary phase diagrams 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  
  
A pseudobinary phase diagram is an equilibrium diagram calculated for a ternary or higher-order 
system, in which the phase boundaries resulting from the variation of two of the element contents 
are calculated, while the amounts of all the other elements are kept constant. 

Contents: 

• Further phase boundary calculations 
• Coping with complex boundary shapes  
• Diagrams with different reference elements  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t9:script:t9.mcs
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1. Setting up the system 

Make a new workspace with the elements Fe, C and Nb and the phases FCC_A1, BCC_A2, LIQUID 
and CEMENTITE. Verify that Fe is selected as the reference element and enter the composition: 0.1 
wt.% C, 0.3 wt.% Nb. Create a new p1-type plot window for the phase diagram.  

2. Fe-C pseudobinary with constant Nb content  

This is similar in many respects to the Fe-Fe3C diagram calculated in Tutorial 8, but the presence 
of niobium stabilises an additional phase, FCC_A1#01 (which is essentially NbC). The stability of 
this phase has a strong dependence on both carbon and niobium contents. Only the low-carbon 
portion of the diagram, from 0 to 0.2 wt.%, is of interest in this tutorial. Begin, as in Tutorial 8, by 
calculating an equilibrium at 1550°C, then search for the BCC_A2 phase boundary. Step from 0 to 
0.2 wt.% C, with an interval of 0.0005 and a maximum T-step of 20. Drag and drop the T$C series 
into the plot and duplicate, lock and label it.  
Add the liquid and austenite (FCC_A1) upper boundaries and the lower boundary of the delta-
ferrite (BCC_A2) to the diagram. Suggested equilibrium temperatures for finding these lines are as 
follows: 

• LIQUID: 1450°C 
• FCC_A1: 1500°C (N.B. the correct value of Tsol 'FCC_A1' should be 1483.41°C.)  
• BCC_A2: 1450°C  

The high-temperature part of the diagram should look like this: 
  

 
  
Next, calculate the boundary for niobium carbide (FCC_A1#01). The temperature of the boundary 
depends strongly on carbon content, but an equilibrium at 1450°C gives a suitable starting point 
for finding it. 
Increase the maximum T-step to 100 to cope with the steepness of the curve. The boundary may 
extend to very small temperature values; in this case, change the scale on the y-axis to '500..' so 
that only the relevant information is shown.  
The final three lines can be calculated as follows: 

• Upper boundary of alpha-ferrite (BCC_A2): 900°C. The maximum T-step can be reduced 
again to 20.  

• Lower boundary of austenite (FCC_A1): 700°C.  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t8
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t8
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• Upper boundary of cementite 800°C. In case of error message (because of the steep 
boundary), set the maximum T-step to 100.  

The finished diagram, with titles and labels added, should look like this: 
  

 

3. Fe-Nb pseudobinary with constant C content 

In this case, the niobium content is to be varied from 0 to 1 wt.% for the stepped calculations. 
Proceed as before, by calculating an equilibrium at 1550°C and searching for the BCC_A2 phase 
boundary. For the stepped calculation, enter 0, 1 and 0.01 as the start, stop and interval values 
and under 'Boundary conditions', change the varying element to 'NB'. 
The boundaries can be calculated with the same starting equilibrium temperatures as for the Fe-C 
diagram, because the basis composition used for calculating the equilibrium and finding a point on 
the boundary remains the same (0.1 wt.% C, 0.3 wt.% Nb). Search for and plot all the following 
boundaries: 

• Upper boundary of delta-ferrite (BCC_A2) 
• Lower boundary of liquid  
• Upper boundary of austenite (FCC_A1)  
• Lower boundary of delta-ferrite  
• Upper boundary of alpha-ferrite (BCC_A2)  
• Lower boundary of austenite  
• Upper boundary of cementite (may need modification of maximum T-step to 100-200)  

The NbC (FCC_A1#01) boundary is slightly more complex in this example, so it will be considered 
in more detail. Firstly, calculate an equilibrium at 750°C and search for the FCC_A1#01 phase 
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boundary varying niobium content. This is at 4.44e-5 wt.% Nb. Make a stepped calculation from 0 
to 1 wt.% Nb as usual. Part-way through this calculation, the following message is displayed: 
  

 
  
The calculation starts at the niobium content used to calculate the equilibrium (0.3 wt.%), and this 
is first increased up to the 'stop' value (1 wt.%, in this case) and then decreased to the 'start' 
value (0). The message above implies that the calculation cannot proceed any further in the 
increasing-Nb direction. Click on 'Yes' to calculate the decreasing-Nb part of the boundary. It can 
be seen that the NbC curve terminates at the 'cementite' line. Also in the larger Nb content 
range, the curve is cut at a niobium content of around 0.57 wt.%. 
In order to find the phase boundary outside these limits, additional calculations must be 
performed. Dealing with the NbC phase boundary below the 'cementite' line is quite 
straightforward. After locking the previous curve, calculate an equilibrium at 700°C and search for 
the FCC_A1#01 phase boundary at this temperature. Due to the steep boundary, it is 
recommended to set the calculation step to 0.001 and the max. T-step value to 200. The final part 
of the NbC boundary (above the 'liquid' line) is plotted after setting the Nb content to 0.7 wt. %, 
calculating equilibrium for 1000°C and finding the phase boundary for this alloy composition (at 
1466.78°C) - perform a step calculation with the step of 0.01 and max. T-step of 20. The finished 
diagram is shown below. 
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4. Nb-C pseudobinary with constant Fe content 

The final part of this tutorial considers the effect of both C and Nb contents on the stability of NbC. 
Previously, iron has been set as the 'reference element'; this means that when the amount of 
the varying species increases, the amount of iron in the system decreases so that the total 
composition sums to unity. For the Nb-C pseudobinary, niobium will instead be set as the reference 
element, and a fixed iron content will be imposed, so that the sum of niobium content and carbon 
content is constant. In addition, the element contents will be expressed in mole fractions, so that 
the effect of Nb:C ratio on carbide stability can be investigated. Open 'Global > Composition' and 
switch to 'mole fraction'. Change the reference element from Fe to Nb. Enter the compositions 
0.995 Fe, 0.004 C. 
As usual, search for the upper boundary of the delta-ferrite phase. This should be found at 
1529.63°C. In the stepped calculation dialogue box, enter 0, 0.005 and 1e-5 as the start, stop and 
interval values. Set the varying element to 'C' and the maximum T-step to 20. In the 'Options' 
section on the right-hand side of the box, remove the selection mark by the side of 'Composition in 
weight percent' so that it will instead be in mole fraction. 
Calculate the following lines. The solution temperatures are given as a guide, as well as notes on 
calculation settings. 

• BCC_A2: 1529.63°C 
• LIQUID: 1486.84°C. A warning message may appear; accept this with 'Yes'.  
• FCC_A1: 1487.04°C. The same warning may appear.  
• BCC_A2: 1447.56°C  
• BCC_A2: 882.04°C. Step from 0 to 0.00498 rather than 0.005 to avoid convergence 

problems.  
• FCC_A1: 726.62°C. Step from 0 to 0.00498. 
• CEMENTITE: 726.62°C  

Finally, the line for FCC_A1#01 can be calculated. Search for this line, which should be found at 
1255.80°C. The temperature of this phase boundary decreases very steeply at both extremities of 
the x-axis, because the phase becomes less and less stable as either the niobium content or the 
carbon content tends to zero. To obtain an idea of the shape of the curve, set the start and stop-
values as 0.0001 to 0.0049 (A maximum T-step of 20 is OK for this calculation.) Modifications can 
then be made to the calculation parameters, decreasing the start value, increasing the stop-value 
and increasing the maximum T-step to try to extend the curve further towards the edges.  
The finished diagram should look like this: 
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T10: T0- temperature in Fe-Cr-C 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents: 

• T0- temperature calculation 
• Martensite / Bainite transformation 
• Variation of T0- temperature with carbon and chromium content 
• Import and display of experimental data into plots 

The T0-temperature is defined as the temperature where two phases of identical chemical 
composition have the same molar Gibbs free energy. This temperature is an important quantity in 
the field of diffusionless phase transformations, i.e. the bainitic and martensitic 
transformation. In the present example, we will discuss some thermodynamic aspects of the 
austenite/martensite transformation and apply T0-temperature calculations to the evaluation of 
transformation temperatures. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t10:script:t10.mcs
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Step 1: Define the thermodynamic system (see also Tutorial T2) 

Create a new workspace file. From a suitable database (mc_sample_fe.tdb) define the elements 
Fe, Cr and C as well as the phases BCC_A2 (ferrite) and FCC_A1 (austenite). Enter the system 
composition with wp(C) = 0.1 and wp(Cr)=1.0. Set initial values with 'Calc - Set start values' 
or Ctrl+Shift+F. Calculate an equilibrium at 800°C. 
  

Step 2: Calculate the T0- temperature 

Before evaluation of the T0-temperature, an equilibrium located in the one-phase region of the 
parent phase must be calculated in order to set the composition of one of the phases equal to 
the system composition. The parent phase is austenite so the solubility temperature of BCC_A2 
will be evaluated with 'Calc - Search phase boundary...' or Ctrl+Shift+T. As a result, MatCalc 
displays in the 'Output'window  
  
Tsol 'BCC_A2': 856,87 C (1130,03 K) iter: 5, time used: 0,03 s 
  
In the 'Phase summary' and 'Phase details' window, only the FCC_A1 phase is denoted as 
active (mole fracton = 1). We can now proceed with this initial condition. For convenience, store 
this (current) state in a calculation state with the name 'Start austenite' by selecting 'Global - 
CalcStates - Create...'.  
  

 
  

 
  
We can now evaluate the T0- temperature for austenite and ferrite with 'Calc - Search phase 
boundary...' or Ctrl+Shift+T. The following, well-known, dialog box appears: 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
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Select 'T0- temperature' in the type listbox, 'BCC_A2' as target phase and 'FCC_A1' as parent 
phase. The check box 'Force target to parent composition' must be chosen, because the 
composition of BCC_A2 wil be adjusted according to the parent composition. The energy difference 
(DFM offset) can be left as default (zero). Press 'Go' to start the calculation. The result is shown 
below 
  
T0(FCC_A1/BCC_A2): 793,394 C (1066,55 K)  
iter: 2, time used: 0,05 s 
- OK -  
  
The phase details window shows: 
  
#### /FCC_A1/ moles: 1, gm: -47047.2 (-47047.2), sff: 0.995371  
Phasestatus: entered - active 
FE +9.84677e-001 CR +1.06937e-002 C +4.62933e-003  
  
### inactive ### 
  
#### /BCC_A2/ moles: 0, gm: -47047.2 (-47047.2), sff: 0.995371 
Phasestatus: entered - not active (dfm=3.412e-009) 
FE +9.84677e-001 CR +1.06937e-002 C +4.62933e-003  
  
It is obvious that, at the temperature of 793.394°C, FCC_A1 and BCC_A2 of the same composition 
have the same molar Gibbs free energy of gm=47047.2 J/mole. 
  

Step 3: Evaluate T0- temperature as a function of chromium content 

Let us now investigate how the T0- temperature for ferrite and austenite varies with the chromium 
content. From the menu select 'Calc - Stepped calculation…'or press Ctrl+T. In the left listbox 
of the 'Step equilibrium ...' window, select type 'T0 temperature'. Select 'FCC_A1' for the 
parent phase and 'BCC_A2' for the target phase. Don't forget to select chromium as the 
independent element. Enter the chromium range between '0' and '10' weight percent in steps of 
'0.5' and don't forget to mark the 'Force identical composition' box. The 'Step equilibrium ...' 
window looks now as follows. 
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Press 'Go' to start the calculation. The result can be displayed in the well known 'XY-data' plot. 
Create the plot and drag and drop the T$c variable from the variables window into the plot. Edit 
the 'x-axis', 'y-axis' and 'legend' (see also Tutorial 4 or Tutorial 5) such that the result of the 
stepped T0- temperature calculation looks as follows. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t4
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
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Step 4: Evaluate T0-temperature as a function of carbon content 

In the same way, similar to the evaluation of the dependence of the T0- temperature on the 
chromium content, it is possible to calculate the T0- temperature as a function of the carbon 
content. Therefore, rename the '_defaullt_'buffer selecting 'Global - Buffers - Rename ...' and 
give it the name T0 - chromium. Then create a new buffer ('Global > Buffers > Create ...') with 
the name T0 - carbon and load the calculation state 'Start austenite' (make sure that the 
current buffer is the 'T0 - carbon' - buffer). Analogously to the calculation before, carry out a 
stepped calculation. Press 'Calc - Stepped calculation ...' or press Ctrl+T, enter the following 
settings and press 'Go'. 
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The graph for the T0- temperature dependence for varying carbon content should look like the 
figure below. There is no need to create a new plot. The T0- temperature line in the figure can 
be simply changed by switching from 'T0 - chromium' buffer to the 'T0 - carbon' buffer in the 
options window.  
  

 
  
Afterwards, the x- and y-axes must be rescaled and in the case of the x-axis renamed. So the 
result looks as follows. 
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The strong dependence of the T0- temperature on the carbon content is evident. This is reflected in 
the strong influence of carbon on the martensite start temperature. 

Step 5: Add some experimental data on martensite start temperatures 

The experimental data, which will be added to the recent plot, are taken from ref. [1]. Before doing 
so, we must create a new buffer. So, none of the former results will be lost. Name the new buffer 
as 'T0 with offset' (further calculations with various dfm-offsets well be done ...) and create a 
table selecting 'Global - Tables ...'. Press 'New ...' and call the table 'Exp. data'. After selecting 
'Edit ...', enter the following measured martensite start temperatures into the table or copy them 
from a file (the file is here). 
  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t10:script:t0_exp_temperatures.xls
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Carbon 
content 
[wt%]  

Martensite 
start 
temperature 

0 540 

0.086 510 

0.1936 475 

0.2409 480 

0.2495 470 

0.2581 440 

0.3011 430 

0.3226 410 

0.3871 410 

0.3871 400 

0.3871 395 

0.4560 405 

0.4947 355 

0.5054 375 

0.6022 330 

0.6022 320 

0.7097 280 

0.7312 280 

0.7743 265 

0.8173 240 

0.8603 225 

  
  
Press 'OK' twice and insert the experimental data into the plot as a new series (right-click in 
'options' window and select 'New series > table experimental data') and switch to 'Exp. 
data' in 'connected to' box (see also Tutorial 5). 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t5
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Rescale the y-axis (set scaling as 'auto') and edit the legend and the series names. The result 
looks as follows. 
  

 
  
Apparently, the calculated T0- temperature does not fit the experimental data, however the curve 
runs parallel to it with the calculated temperatures being higher. The reason is that a certain 
amount of driving force is required to start the martensite transformation. This extra energy, or 
extra driving force, is of the order of 1.2 to 2.5 kJ/mol (depending on the composition of the alloy) 
and can be defwwined in the field dfm-offset. Default value for this parameter is zero.  
  
To evaluate how high this extra energy is as a function of carbon content, stepped calculations with 
different dfm-offsets can be performed. Carry out two simulations, one as a steped T0- temperature 
calculation with a dfm-offset of 1200 J/mole and one with 1700 J/mole. Before starting lock 
the first series (T0- dfm=0 J/mole). So the first graph will be conserved for further comparison. 
Select 'Calc - Stepped calculation ...'and complete the dialog box as follows: 
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Drag and drop the 'T$c' variable again into the plot and rename the series to T0 - dfm=1200 
J/mole. Do the same for a dfm-offset of 1700 J/mole. The plot now looks like follows. 
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A dfm-offset in the range of 1200-1700 J/mole can be used to obtain reasonable agreement 
between the calculations and the experimental data. 
  

References 

[1] Z. Jicheng and J. Zhanpeng, Acta met. mater. 38 (1990) 425-431. 
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T11: Simulation of solidification of 0.7C 3Mn steel  

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents: 

• Scheil calculation 
• Back-Diffusion 
• Composition set 
• Solid-solid transformation 

The Scheil-Gulliver method allows calculating the fraction and composition of all phases 
during solidification step by step from the liquidus temperature to the temperature where 
solidification of the residual liquid phase occurs [1-3]. The particular residual fraction at final 
solidification is dependent on the cooling rate. Generally, the fraction is higher, the higher the 
cooling rate is. At slow cooling rates, the liquid film can become very thin and the residual liquid 
enriches more than in the case of higher fraction residual liquid at solidification. 
According to the Scheil-Gulliver hypothesis, illustrated in the figure below (Fig.1), a solidifying 
liquid with the initial composition C0 is slightly undercooled. Consequently, a certain fraction of 
solid is formed with a composition of CS,1 with the remaining liquid phase with the composition CL,1. 
Both phases are in local equilibrium following the lever rule. From that instant on, the 
composition of the solid phase with regard to the substitutional atoms is frozen due to the Scheil-
Gulliver assumption of very slow (and therefore negligible) diffusion in the solid phase. The 
interstitial elements boron, carbon and nitrogen are assumed to be nevertheless highly mobile in 
the liquid phase as well as the solid phase. Therefore, these elements are assumed to be able to 
establish equilibrium between the liquid and solid phases due to back-diffusion of enriched solute 
atoms from the liquid phase into the solid phase. This process occurs repeatedly, enriching the 
solid phase as well as the liquid phase with solute during cooling (Fig.1:CL,i and CS,i). 
  

 
Fig.1: Scheme of Scheil solidification of a hypothetic Fe-C alloy. During solidification the actual liquid 
phase, beginning with C0, is undercooled and solidifies according to the lever rule enriching the liquid 
phase with solute atoms 
  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t11:script:t11.mcs
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When solidification is finished, the microstructure of the solid phase shows a composition gradient 
from the regions where the solidification started (centre of the dendrite) to the areas where the 
last liquid solidified (outer shell of the dendrite). The composition of the residual liquid at final 
solidification corresponds to the composition of the interdendritic regions. It should be noted that 
the Scheil-Gulliver analysis yields an upper limit of segregation since the substitutional elements 
also have a finite mobility and have some potential of back-diffusion. 
Scheil-type calculations in multi-component systems have proven to be a useful method to 
simulate solidification processes. The present example shows how to carry out this type of 
simulation with MatCalc and demonstrates the effect of carbon back-diffusion on the solidification 
process. Moreover, the influence of solid-solid phase transformations, i.e. the peritectic 
transformation, is analyzed.  
  

Step 1: Setup the thermodynamic system (see also Tutorial T2) 

Create a new workspace file. From a suitable database (mc_sample_fe.tdb) define the elements 
Fe, Mn and C and the phases liquid, BCC_A2 (ferrite), FCC_A1 (austenite) and Cementite. 
  

 
  
Enter the system composition in weight percent as listed in the subsequent figure selecting 'Global 
Composition ...' or pressing the F7 key. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2


Tutorial 11 

 93

 
  
Set initial values with 'Equilibrium-Set start values' or Ctrl+Shift+F. Calculate equilibrium at 
1600°C. The results in the 'Phase summary' window are 
  
LIQUID * act 1,00000e+000 dfm: +0,00000e+000  
### inactive ### 
BCC_A2 - OK - 0,00000e+000 dfm: -1,02442e+003 
FCC_A1 - OK - 0,00000e+000 dfm: -1,08259e+003 
CEMENTITE - OK - 0,00000e+000 dfm: -1,27829e+004 
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Step 2: Carry out a Scheil calculation 

Since we expect austenite to be the first phase to form on solidification, let us first look for the 
solubility temperature of this phase. Select 'Calc - Search phase boundary ...' or 
press Ctrl+Shift+T and select FCC_A1 as target phase. 
  

 
  
Press 'Go': 
  
Tsol 'FCC_A1': 1471,11 C (1744,27 K) iter: 4, time used: 0,03 s 
  
The first solid phase becomes stable at 1471.11°C. So let us start with the Scheil simulation at 
1500°C and go down to 1000°C in steps of 10. Open the Scheil-calculation dialog with 'Calc - 
Scheil calculation ...' or press Ctrl+H. 
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Press 'Go' to start the simulation. In order to be able to remove the equilibrium content of solid 
phases from the system after each temperature step, MatCalc needs to create copies of all 
phases except the dependent (liquid) phase. MatCalc therefore asks 
  

 
  
Click 'Yes'. MatCalc then creates 3 new phases with the name of the original phase plus the suffix 
'_S'. This suffix denotes that the corresponding phase is a 'solid' phase. The result in the 'Output' 
window looks as follows 
  
Checking solid phases ...creating phases: ...- OK -  
- OK - 
Searching initial equilibrium ... 
1, 1.02 s, 1500.00 C (1773.16 K), its 2, f=1.00000000, LIQUID  
... 
3, 1.03 s, 1480.00 C (1753.16 K), its 2, f=1.00000000, LIQUID  
4, 1.05 s, 1470.00 C (1743.16 K), its 5, f=0.96983965, LIQUID FCC_A1  
... 
12, 1.13 s, 1390.00 C (1663.16 K), its 6, f=0.25223994, LIQUID FCC_A1  
13, 1.14 s, 1380.00 C (1653.16 K), its 6, f=0.22786341, LIQUID FCC_A1 
14, 1.16 s, 1370.00 C (1643.16 K), its 6, f=0.20736906, LIQUID FCC_A1 
15, 1.16 s, 1360.00 C (1633.16 K), its 6, f=0.18993222, LIQUID FCC_A1  
... 
39, 1.41 s, 1120.00 C (1393.16 K), its 5, f=0.05684065, LIQUID FCC_A1  
40, 1.42 s, 1110.00 C (1383.16 K), its 11, f=0.00000000, FCC_A1 CEMENTITE 
fraction of phase 'LIQUID' smaller than 1e-006. Finishing in equilibrium mode ... 
41, 1.44 s, 1100.00 C (1373.16 K), its 3, f=0.00000000, FCC_A1 CEMENTITE  
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... 
51, 1.52 s, 1000.00 C (1273.16 K), its 3, f=0.00000000, FCC_A1 CEMENTITE  
Steps: 52, CalcTime: 1.52 s 
AktStepVal: 1273.160000 
- OK -  
  
  
The current value of the fraction liquid at each temperature step is displayed with 'f=xxx' in each 
line. The final eutectic is reached at T=1110°C. When the fraction liquid comes below 1e-6 
(minimum liquid fraction) , the dependent phase is dissolved and the calculation is finished. 
Let's now look at the result. 
Create a XY-data plot that shows the fraction of residual liquid as a function of temperature. The 
correct variable is F$LIQUID, you have to change the default x-data to T$C in the options window 
to show °C instead of K. Rescale the x-axis from 1100°C to 1500°C. A few other settings were 
made until the result looks as follows 
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Step 3: Add a Scheil calculation with back-diffusion of carbon 

The solidification of the current steel as calculated by the Scheil model predicts final solidification at 
too low temperature. In reality, carbon atoms are fast enough not only in the liquid but also in 
the solid to be able to equilibrate between the solid and liquid phases. Therefore, to get more 
realistic simulation results, we must allow for back-diffusion of carbon. First, in order not to 
loose the results of the previous simulation, rename the current buffer to 'Scheil' and create a new 
one with the name 'Scheil with BD of C'. Open the Scheil calculation dialog with 'Calc - Scheil 
calculation ...' or press Ctrl+H. Highlight carbon in the list box and press 'Toggle'. 
  

 
  
Press 'Go' to start the simulation. After each temperature step, MatCalc sets up a paraequilibrium 
calculation, where all elements without back-diffusion have fixed composition variables and only 
the elements with back-diffusion are unconstrained. By that means, carbon is always 
brought back into equilibrium with regard to the solid and liquid phases after a regular Scheil 
simulation step is carried out. 
We are going to display the Scheil curve with and without back-diffusion in one window. Therefore, 
first, lock the previous Scheil calculation, which is still displayed in the diagram window and name 
it 'Scheil'. 
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Then, we make sure that the just created buffer ('Scheil with BD of C') is selected as current 
buffer and drag and drop the 'F$LIQUID' variable into the plot (note that alternatively you can 
use the 'Lock and duplicate series' option accessible via the right mouse button or the 'View' 
menu). Rename the new series to 'Scheil with BD of C'. The new diagram looks like the following 
figure. 
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Step 4: Add the equilibrium solidification path 

Let us finally add the solidification temperatures for thermodynamic equilibrium conditions. To 
speed up the calculations, we suspend all 'solid' phases which were needed for the Scheil 
calculations. Open the 'Phase status' dialog (F8). Set the 'suspended' flag for each 'solid' 
phase. 
  

 
  
Create a new buffer with the name 'Equilibrium'. Open the stepped calculation dialog (Ctrl+T). 
Calculate a stepped calculation with temperature as the variable between 1500°C and 1350°C in 
steps of 5. Press 'Go' to start the calculation.  
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Change the buffer to be used in the diagram window to 'Equilibrium'and drag and drop the 
'F$LIQUID' variable into the plot after locking the previous series as done before. Rename 
the current series and the diagram looks like this: 
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On changing the 'y-axis' type to 'log' and scaling from 0.01, the results finally display as 
  

 
  
From this diagram, and with the assumption that all residual liquid freezes (solidifies) when 1% 
residual liquid is reached, the predicted solidification temperatures using the classical Scheil model, 
Scheil with back-diffusion and full thermodynamic equilibrium can be read as 1110, 1335 and 
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1380°C, respectively. Probably, 1335°C comes closest to the real, experimentally observed 
solidification temperature for this alloy composition.  
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T12: Using the MatCalc console 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 
  

Contents: 

• Getting help in the MatCalc console 
• Obtaining lists of available commands for different modules  
• Command syntax and abbreviations  
• Example: calculating an equilibrium using the command-line  
• Evaluating numerical expressions and variables  
• Defining, using and plotting functions  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t12:script:t12.mcs


Tutorial 12 

 104

1. Basics 

Getting help and listing available commands 

Typing '?' or 'HELP_WORKSPACE' in the console window shows a list of available commands. 
  
  
  
_mcore: ?  
------------------------------------------------------------------------------- 
available commands in workspace module: 
------------------------------------------------------------------------------- 
? HELP_WORKSPACE HELP_MODULE 

ECHO ! EXIT 

USE_MODULE BACK_TO_MODULE NEW_WORKSPACE 

READ_WORKSPACE SAVE_WORKSPACE CLOSE_WORKSPACE 

SET_WORKSPACE_PROPERTY SET_WORKSPACE_INFO LIST_WORKSPACE_INFO 

RUN_SCRIPT_FILE TEST_COMMAND STOP_CURRENT_ACTION 

STOP_RUN_SCRIPT NEW_GUI_WINDOW REMOVE_GUI_WINDOW 

MOVE_GUI_WINDOW SET_GUI_WINDOW_PROPERTY UPDATE_GUI_WINDOWS 

LIST_GUI_WINDOW_PROPS LIST_ALL_GUI_WINDOWS CREATE_NEW_PLOT 

SET_PLOT_OPTION LIST_PLOT_OPTIONS REMOVE_PLOT 

LIST_ALL_PLOTS COPY_PLOT_TO_CLIPBOARD COPY_FRAME_TO_CLIPBOARD 

EXPORT_PLOT_TO_FILE EXPORT_FRAME_TO_FILE LIST_CURRENT_DIRECTORIES 

SET_APPLICATION_DIRECTORY SET_WORKING_DIRECTORY   

SHOW_EXPRESSION     

SET_VARIABLE_VALUE INPUT_VARIABLE_VALUE REMOVE_VARIABLE 

LIST_ALL_VARIABLES SET_VARIABLE_STRING INPUT_VARIABLE_STRING 

FORMAT_VARIABLE_STRING REMOVE_STRING_VARIABLE LIST_ALL_STRING_VARIABLES 

SEND_OUTPUT_STRING SEND_CONSOLE_STRING SEND_DIALOG_STRING 

SET_FUNCTION_EXPRESSION LIST_ALL_FUNCTIONS REMOVE_FUNCTION 

EDIT_SYMBOL EDIT_PARAMETER LIST_SYMBOLS 

LIST_PARAMETERS     
------------------------------------------------------------------------------- 
use HELP_MODULE for module specific commands 
-------------------------------------------------------------------------------  
  
The commands listed above are part of the 'workspace' module of MatCalc and relate to creating 
and modifying workspaces and windows within workspaces. As can be seen from the last line of the 
above transcript, 'HELP_MODULE' gives access to another series of commands relating to the 
current module of the program ('core'), i.e. the calculations themselves: 
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_mcore: help_module  
------------------------------------------------------------------------------- 
available commands in mc_core module:  
------------------------------------------------------------------------------- 
RESTART LICENSE_INFO GIBBS_CALC_STATUS 

LIST_DATABASE_CONTENTS SELECT_ELEMENTS SELECT_PHASES 

SET_REFERENCE_ELEMENT ENTER_COMPOSITION SET_TEMPERATURE_CELSIUS 

SET_TEMPERATURE_KELVIN SET_PRESSURE SET_AUTOMATIC_STARTVALUES 

APPLY_TANGENT_CONSTRUCTION CALCULATE_EQUILIBRIUM SEARCH_PHASE_BOUNDARY 

STEP_EQUILIBRIUM LIST_EQUILIBRIUM LIST_CORE_STATUS 

SET_STEP_OPTION LIST_STEP_OPTIONS CHANGE_PHASE_STATUS 

LIST_PHASE_STATUS CREATE_NEW_PHASE REMOVE_PHASE 

<<CORE>> <<NODES>> <<SYMBOLIC>> 

<<IO>> <<PRECIPITATION>> <<STATE>> 

<<BUFFER>> <<TABLES/ARRAYS>> <<TRANSFORMATIONS>> 

<<HEAT_TREATMENTS>> <<EXPORT>>   

  
_mcore:  
  
The 'mcore' module contains several subsections, given in triangular brackets below the list of 
commands. These can be opened by typing in 'HELP_MODULE' again with the name of the 
subsection. For example 'HELP_MODULE IO' lists the input/output commands. 
  
_mcore: help_module io  
------------------------------------------------------------------------------- 
available commands in mc_core module: IO 
------------------------------------------------------------------------------- 
OPEN_THERMODYN_DATABASE READ_THERMODYN_DATABASE READ_MOBILITY_DATABASE 

READ_PHYSICAL_DATABASE SET_LOG_FILE  WRITE_BINARY_FILE 

READ_BINARY_FILE SET_AUTOSAVE_FILENAME   
_mcore:  

Notes on syntax 

1. Although the commands listed above contain underscores '_', the hyphen '-' can be used 
interchangeably with the underscore when typing commands. Note, however, that this is not the 
case in names of phases such as 'BCC_A2', which require the underscore. 
2. Commands are case-insensitive. 
3. Any unambiguous abbreviations of the commands are allowed. For example, 'open_th' or even 
'o_t' are acceptable abbreviations of 'open_thermodyn_database'. Using an ambiguous 
abbreviation, such as 'read', gives a list of all possible commands with that abbreviation, together 
with a message indicating that the command was ambiguous: 
  
_mcore: read 
READ_WORKSPACE 
READ_THERMODYN_DATABASE 
READ_MOBILITY_DATABASE 
READ_PHYSICAL_DATABASE 
READ_BINARY_FILE 
*** error *** ambiguous command 
_mcore: 

2. Example: calculating an equilibrium using the command-line 

The use of command-lines will be illustrated with a simple example: setting up a workspace and 
calculating an equilibrium at a single temperature. This is the same calculation as in Tutorial 2: an 
equilibrium at 700°C in a Fe-0.4 wt.% C system containing the phases LIQUID, FCC_A1, BCC_A2 
and CEMENTITE. 
Start with a new workspace. (Warning! Using the 'new_workspace' command does not prompt 
the user to save any previously open workspace files, so make sure any necessary changes are 
saved first.) 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t2
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_mcore: new_workspace 
<script(0)>  
<script(0)> $ running autonew.mcs script ... 
<script(0)> m-gui-w 0 0 500 900 450 
<script(0)> n-gui-w a6 
<script(0)> m-gui-w . 500 0 500 450 
<script(0)> n-gui-w a5 
<script(0)> m-gui-w . 0 0 450 300 
<script(0)> set-workspace-prop m n 
<script(0)>  
<script(0)> $ ready ... 
<script(0)>  
_mcore: 
  
Open the thermodynamic database. This is equivalent to clicking 'Open' in the 'Global > 
Databases' dialogue box. 
  
_mcore: open_thermodyn_database 
name for thermodynamic database ('*' for list) /mc_sample_fe.tdb/:  
  
The console prompts the user for the name of a database. The default option is given between 
slashes '/../' (By typing '*' and pressing 'enter', the content of the ...\MatCalc\database 
directory is shown). Press 'enter' to accept the default 'mc_sample_fe.tdb' database. Find out 
which elements and phases are in the database using 'list_database_contents': 
  
_mcore: list_database_contents  
(e)quilib/(d)iffusion/(p)hysical /e/: e 
equilibrium database file: C:/Programme/MatCalc/database/mc_sample_fe.tdb 
# of elements in database: 15 
VA, AL, C, CR, CU, FE, MN, MO, N, NB, NI, SI, TI, V, W 
# of phases in database: 15 
LIQUID FCC_A1 BCC_A2 
HCP_A3 ALN CEMENTITE 
CU_S GRAPHITE M23C6 
M6C M7C3 LAVES_PHASE 
KSI_CARBIDE M3C2 SIGMA 
V3C2 CR2VC2 FE4N 
MN6N4 MN6N5 ZET 
  
Select the required elements using 'select_elements c fe'. A message appears to indicate that C 
has been selected, and Fe has been ignored because it was already selected by default.  
  
_mcore: select_elements c fe 
element 'C' selected 
element 'FE' ignored 
  
Next select the phases. Any unambiguous abbreviation is acceptable for the phase names. 
Messages appear to confirm that these phases have been selected. 
  
_mcore: select_phases liq bcc fcc cem 
phase 'LIQUID' selected 
phase 'BCC_A2' selected 
phase 'FCC_A1' selected 
phase 'CEMENTITE' selected 
  
Read in the thermodynamic data. This is equivalent to clicking 'read' in the 'Databases' dialogue 
box. 
  
_mcore: read_thermodyn_database 
  
Enter the composition. There are three available unit qualifiers: x (mole fraction), u (u-fraction) 
and w (weight fraction). In addition, appending 'p' to any of these gives the unit in percent. See 
the example below, in which the composition is specified in weight percent.  
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_mcore: enter_composition 
unit qualifier (X/U/W + P) /x/: wp 
enter amount (e.g. Mn=0.32 C=0.01): c=0.4 
  
Open 'Databases', 'Composition' and 'Phase Status' from the 'Global' menu and note that the 
system setup entered using the command-line is shown in the GUI windows. Console and GUI 
versions of commands can be used completely interchangeably.  
Set the temperature to 700°C. Note that there are two commands for temperature, 
'set_temperature_celsius' and 'set_temperature_kelvin', depending on the units of interest.  
  
_mcore: set_temperature_celsius 700 
  
Impose automatic start-values and calculate an equilibrium. 
  
_mcore: set_automatic_startvalues 
_mcore: calculate_equilibrium 
  
Note the results in 'phase summary' window: the stable phases are BCC_A2 and CEMENTITE as 
expected. 

3. Evaluating expressions 

As well as entering commands, the console can be used to evaluate numerical expressions, MatCalc 
variables and user-defined expressions and functions. 

Numerical expressions 

Any numerical expression can be evaluated using the command 'SHOW_EXPRESSION' ('show' 
or 'sh' are acceptable abbreviations): 
  
_mcore: show 4/5 
4/5 =  
            0.8 
_mcore: show pi 
pi =  
   3.14159265359 
  
Note the priority rules and the use of parentheses to override these, e.g.: 
  
_mcore: show 4/5*3 
4/5*3 =  
            2.4 
_mcore: show 4/(5*3) 
4/(5*3) =  
   0.266666666667 
_mcore: show 4+4*2 
4+4*2 =  
             12 
_mcore: show (4+4)*2 
(4+4)*2 =  
             16 

Expressions in x 

Expressions in terms of the current value of the stepped variable, x, can be evaluated using 
'show_expression', as shown below. (The value of x is currently zero because no stepped 
calculation has so far been performed in this workspace.) 
  
_mcore: show 3*x 
3*x =  
              0 
  
Functions in x can be defined and then evaluated. 
  



Tutorial 12 

 108

_mcore: set-function-expression 
which function: function1 
enter expression: 3*x 
_mcore: show function1 
function1 =  
              0 
  
Pressing the up-arrow recalls the latest command to be entered. Further use of this up-arrow 
scrolls through the command history in reverse chronological order. Commands are given with the 
full names and chosen options, e.g.: 
  
_mcore: SET_FUNCTION_EXPRESSION function1 3*x  
  
The command-line can then be edited: 
  
_mcore: SET_FUNCTION_EXPRESSION function2 
enter expression: x**2 
  
This is the expression for x2. The syntax 'x^2' can also be used for the same purpose: 
  
_mcore: SET_FUNCTION_EXPRESSION 
which function /function2/: function3 
enter expression: x^2 
  
The functions just defined can now be found by opening the 'Functions' tab in 'Global > 
Variables & functions', and in the 'variables' window under 'functions'. They can be plotted in 
a new window as follows: 
Firstly, create a new window and enter the window-type code. These codes can be found under 
'View > Create new window'. The standard x-y plot is 'p1'. 
  
_mcore: new_gui_window 
enter window-type code: p1 
  
Next, add a new series using set-plot-option and choosing the following options: 
  
_mcore: set-plot-option 
enter plot ID /1/:  
(t)itle/(a)xis/(l)egend/(h)istogram/(s)eries: s 
(n)ew/(e)dit/(r)emove/rena(m)e/(l)ock/(d)erive/(c)onvert to table: n 
(b)uffer results/(t)able/experimental data/(f)unction/expression: f 
expression in variable 'x': function1 
definition range /auto/: -10..10 
  
Finally, add the other two series by recalling and editing the previously used command. 
  
_mcore: SET_PLOT_OPTION 1 S N F function2 -10..10  
_mcore: SET_PLOT_OPTION 1 S N F function3 -10..10 
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The resulting plot should look like this: 
  

 

Expressions using MatCalc variables 

It is also possible to define functions made up of MatCalc variables. Here, two functions similar to 
those discussed in Tutorial 6 are defined. The built-in variables can be copied and pasted from the 
'variables' window to the console using the right-click menus or Ctrl+C and Ctrl+V. 
  
_mcore: SET_FUNCTION_EXPRESSION function4 F$BCC_A2*X$BCC_A2$C 
_mcore: SET_FUNCTION_EXPRESSION function5 F$CEMENTITE*X$CEMENTITE$C 
  
These new functions can then be evaluated using 'show': 
  
_mcore: show function4 
function4 =  
   0.000627105512124  
_mcore: sh function5 
function5 =  
   0.01770390510026 
  
Expressions can be built up from existing functions and variables: 
  
_mcore: show function4+function5 
function4+function5 =  
   0.0183310105147 
  
Below, it is confirmed that, at 700°C, function4 + function5 = XS$C i.e. all the carbon in the 
system is in the form of either BCC_A2 or cementite, since these are the only two phases to be 
stable at this temperature. 
  
_mcore: show XS$C-(function4+function5) 
xs$C-(function4+function5) =  
              0 
  
The next tutorial discusses the use of command-lines in scripts to facilitate repetitive or complex 
tasks. 

 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t6
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T13: Introduction to scripting (1: Equilibrium calculations) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb 
Click here to view the script for this tutorial 

Contents: 

• Purpose of scripts  
• Writing a script to perform a stepped calculation and display the results 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t13:script:t13.mcs


Tutorial 13 

 111

1. Introduction 

Utility of scripts 

A script is a text file, containing a list of commands to be executed in order from top to bottom. 
They are particularly useful to speed up routine or repetitive operations. Once a script file has been 
created, it can easily be modified to serve a new purpose, for example by changing the elements or 
phases in the system. Script files, consisting only of text, are also much smaller in size than 
MatCalc workspace files, especially those resulting from precipitation calculations. 
Individual scripts can also be grouped into master-scripts; this facilitates, for example, calculations 
involving multi-stage heat treatments (see the examples of those in Application section). 

Writing a script 

There are two ways of creating a script: 
1. In MatCalc, choose 'New' from the 'File' menu and select 'Text file' from the drop-box. Note 
that it is possible to have any number of text files open simultaneously with a MatCalc workspace 
file. 'Save' or 'Save as' will save the text file if its window is highlighted, otherwise the workspace 
will be saved. Recently used text files can be found in a list under 'File > Recent files'. 
2. Alternatively, create the new script in any text editor (which saves files as plain text), such as 
notepad, emacs, vi or any of the many text editors available in different Linux distributions. 
  
N.B.- The MatCalc scripts have '.mcs' extension so it is important to set (or change) the 
extension of the created file! 
  

Reading a script 

There are three ways of loading a script: 

1. Using 'File > Open' or clicking on icon in the toolbar (keyboard shortcut 'Ctrl + O'). Select 
the filter to 'MatCalc script (*.mcs)' files 

2. Using 'Extra > Run script' or clicking on icon in the toolbar (keyboard shortcut 'Shift + 
F2') 
3. Double-clicking on the '.mcs' file icon 

2. Example: a stepped equilibrium  

This example will show how to write a script to perform the stepped calculation in Tutorial 3 and 
display the results.  

Comments 

It is always advisable to comment the script extensively so as to help other users (or oneself 
several months later!) to understand the aim of the calculation, assumptions, etc. 
Any line prefixed with a '$'-sign will not be interpreted as a command. The '$'-sign can also be 
inserted part-way through a line; the rest of the line will be treated as a comment. 
  
$ This whole line is a comment. 
NEW_WORKSPACE $ The rest of this line is a comment.  
  
Both comments and commands are shown line-by-line in the console when the script is executed, 
but prefixing a comment or a command with the '@'-sign hides the line so that it does not appear 
in the console output. 
At the beginning of the script, enter some preliminary comments, containing such information as: 
the name of the file, the current version of MatCalc (available from Help > About), the current 
version of the scripting language and a brief summary of the purpose of the script. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t3
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$ Script T13 
$ This is a script for MatCalc version 5.41 
$ MatCalc script version 1  
$ Calculating equilibrium phase stability in Fe-0.4C wt.% 
  
Save the file as 'T13.mcs' 

Calculating an equilibrium 

The first executable line in the script creates a new workspace (N.B.- Any previously open 
workspace will be closed without warning.) 
  
@$************************************ 
$ Create a new workspace file 
@$************************************ 
new_workspace $this executes 'autonew.mcs' script 
  
The next lines are to enter some workspace information to describe the ideas, assumptions etc. 
used in the calculation. This information can be found in 'File > Workspace info'. The '+'-sign 
continues the text on a new line.  
  
@$************************************ 
$ enter workspace info 
@$************************************ 
@ set-workspace-info Script T13 
@ set-workspace-info +Calculation of equilibrium phase stability 
@ set-workspace-info +in Fe-0.4C wt.% system 
@ set-workspace-info +with phases LIQUID, BCC_A2, FCC_A1 and CEMENTITE. 
  
Next, add the command-line to open the thermodynamic database. 
  
@$************************************ 
$ open the thermodynamic database 
@$************************************ 
open_thermodyn_database 
  
If the line is put in as above, the script will stop at this point and prompt the user for the name of a 
thermodynamic database. The output in the console window is as follows: 
  
<script(0)> $ open the thermodynamic database 
<script(0)> open_thermodyn_database 
name for thermodynamic database /mc_sample_fe/:  
  
(Press 'enter' to select the default option.) Leaving out the arguments of the command in this way 
allows for interactivity in scripts. If, instead, the script is intended to be fully automatic, the 
argument should be put after the command on the same line. Replace the above line with the 
following: 
  
open_thermodyn_database mc_sample_fe.tdb 
  
The next parts of the script are to set up the system, set the temperature and calculate an 
equilibrium. These commands have already been seen in Tutorial 12. 
  
@$************************************ 
$ select elements and phases 
@$************************************ 
select_elements c fe 
select_phases liq bcc fcc cem 
@$************************************ 
$ read in the thermodynamic data 
@$************************************ 
read_thermodyn_database 
@$************************************ 
$ enter the composition 
@$************************************ 
enter_composition wp c=0.4 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
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@$************************************ 
$ set the temperature and calculate an equilibrium 
@$************************************ 
set_temperature_celsius 700 
set_automatic_startvalues 
calculate_equilibrium  

Stepped calculation 

In the line below, the argument 'r' means range, and the numerical values are the start, end and 
step interval. 
 
@$************************************ 
$ define step parameters and make stepped calculation 
@$************************************ 
set_step_option r 400 1600 L 25 
step-equilibrium 

Graphical output 

The final part of the script is concerned with graphical presentation of results. The following line 
creates a new GUI window to contain the plot. As was seen in Tutorial 12, the code 'p1' is used to 
open an XY-plot.  
 
@$************************************ 
$ graphical output 
@$************************************ 
new-gui-window p1  
  
The following three lines change the default x-data from 'StepValue' to temperature in Celsius, set 
a default x-axis to be used for all plots, and provide a title for this axis. The '.' in these lines refers 
to the ID of the last-used window, which in this case is the p1 window which has just been created.  
  
set-gui-window-property . x t$c 
set_gui_window_property . s u y $ set default x-axis to be used for all plots 
set_gui_window_property . s t Temperature [°C] $ title for default x-axis 
  
The line below adds a title to the diagram. This first diagram is to be a plot of phase fraction versus 
temperature. 
  
set-plot-option . t Phase stability in Fe-0.4 wt.% C 
  
The following lines label the y-axis, change the 'factor' of the y-axis from 1 to 100 to display the 
calculated phase fraction directly in percent, set the axis type to logarithmic and modify the axis 
scaling. 
  
set-plot-option . a y 1 t Phase fraction [%] 
set-plot-option . a y 1 f 100 
set-plot-option . a y 1 y log                       $ changes axis type to log 
set-plot-option . a y 1 s 1..100                    $ modifies axis scaling 
  
The first series is inserted using 'set-plot-option . s n b f$liquid'; this is the phase fraction of 
liquid. The name of the series, as it will appear on the legend, is then edited using 'set-plot-
option . s m -1 f$liquid Liquid'. This changes the name from its automatic value (f$liquid) to 
'Liquid'.  
  
set-plot-option . s n b f$liquid  
set-plot-option . s m -1 f$liquid Liquid 
  
These commands are repeated for the other phases. Note the use of the HTML markup tags to give 
the subscript in 'Fe3C'.  
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t12
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set-plot-option . s n b f$bcc_a2  
set-plot-option . s m -1 f$bcc_a2 Ferrite 
set-plot-option . s n b f$fcc_a1  
set-plot-option . s m -1 f$fcc_a1 Austenite  
set-plot-option . s n b f$cementite 
set-plot-option . s m -1 f$cementite Fe<sub>3</sub>C 
  
The three lines below move and resize the window, update its contents and set the style-sheet to 
coloured with no symbols. In the first of these lines, the first two numbers define the position of 
the window, the second two define the width and height. 
  
move_gui_window . 20 20 800 1000 
update-gui-window . 
set_gui_window_property . y col_no_symb $sets style-sheet to colour with no 
symbols. 
  
Another plot can be added in the current window as shown below 
  
create_new_plot x . 
  
The newly created plot now becomes the 'current' plot and can be referred to as '.' when it is being 
modified with set_plot_option: 
  
set_plot_option . t Composition of phases  
set-plot-option . a y 1 t Carbon content [wt.%] $ label on y-axis 
set-plot-option . s n b x$liquid$C wp $ adding the first series... 
set-plot-option . s m -1 x$liquid$C Liquid $... and changing its name. 
set-plot-option . s n b x$bcc_a2$C wp 
set-plot-option . s m -1 x$bcc_a2$C Ferrite  
set-plot-option . s n b x$fcc_a1$C wp  
set-plot-option . s m -1 x$fcc_a1$C Austenite  
set-plot-option . s n b x$cementite$C wp 
set-plot-option . s m -1 x$cementite$C Fe<sub>3</sub>C 
  
The script can be concluded with the following line, which should appear in the console when the 
script has been executed without any errors. 
  
$ *** DONE *** 
  
The script 'T13.mcs' can be found in the 'download' folder. 
The final diagrams should look like this: 
  

 



Tutorial 13 

 115

 



Tutorial 14 

 116

T14: Introduction to precipitation calculations 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb; mc_sample_fe.ddb 
Click here to view the script for this tutorial 

Contents: 

• Precipitation of cementite in a ferritic matrix in Fe-0.2 wt.% C 
• Creating a precipitation domain 
• Creating a precipitate phase  
• Mobility and physical data  
• Plotting and interpreting calculation results  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t14:script:t14.mcs
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1. Setting up the system 

A. Thermodynamic setup 

The first step is to set up the thermodynamics of the system. In the new workspace, open 'Global 
> Databases' and select the elements Fe and C. For a precipitation calculation, it is only 
necessary to include the phases which are directly involved in the precipitation, i.e. the 
precipitating phase and the matrix in which it forms. This example considers the precipitation of 
cementite in ferrite, so the two phases to be selected are BCC_A2 and CEMENTITE. When the 
thermodynamic data have been read in, open 'Global > Composition' and enter the carbon 
content of 0.2 wt.%. 

B. Precipitation domain 

The next two steps are to define and configure the precipitating phase and the domain in which it 
will form. These two steps can be done in either order, but in this example, the precipitation 
domain will be set up first. 
Open 'Global > Precipitation domains' and click on the 'New' button towards the bottom left. A 
box will appear, prompting for a name for the new domain. Any name can be chosen here, for 
example 'Ferrite' or 'Matrix' and click 'OK'. 
  

 
  
On the 'Phases' tab, choose 'BCC_A2' from the drop-box to associate this phase with the newly 
defined domain. Leave the rest of the settings as they are, and click 'OK'. 
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C. Precipitate phase 

To create the precipitate phase, open 'Global > Phase status'. In the 'Phases' list on the left-
hand side, select 'CEMENTITE' and click on 'Create'. Select 'precipitate (_Pnn)' from the drop 
box which opens. 
  

 
  
A new phase, CEMENTITE_P0 appears in the phase list; click on this to select it. Open the 
'precipitate' tab, and enter '250' in the '# size classes' box, click on 'Initialize' and accept the 
warning message. The precipitates are considered as belonging to a number of classes of particles 
with the same radius and composition. Classes are created, rearranged and deleted during the 
calculation, allowing simulation of the precipitate size distribution.  
The choice of the number of classes represents a trade-off between calculation time and required 
precision. If only average properties, such as the mean precipitate radius, are of interest, then it is 
sufficient to use a small number of classes such as 10 or 20. By contrast, to obtain the best 
possible simulation of size distribution, the number of classes should be increased to a higher 
value, such as 250 as used here. Leave all the other settings in this tab as they are. 
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In the 'Attached to pd' drop box select the created domain ('Ferrite') 
  

 
  
Open the 'nucleation' tab. If the contents of the 'Nucleation model' and other drop-boxes are 
not visible, click on another phase in the phase list at the left-hand side, then back on 
'CEMENTITE_P0', and this will load the text. 
In the 'Nucleation sites' part of this tab, remove the tick-mark by 'bulk (homogeneous)' and 
instead click in the box beside 'dislocations' . Click on 'OK' to save these settings and return to 
the main screen. 
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D. Loading mobility data 

Simulations of precipitation require not only thermodynamic data (already loaded in step A) but 
also mobility data, from which the diffusivities of the elements in the phases can be calculated. 
Read in the mobility data by opening 'Global > Databases' and select 'Diffusion data' on the 
left side. Click on 'Read' and open 'mc_sample_ddb' database. Click on 'close' 
  

 

E. Creating plots for the output 

Create a new 'Plot: XY-data' window. Drag and drop 'F$CEMENTITE_P0' from the variables 
window to this plot. In the 'options' window, set 'default x-axis' to 'log' type and select 'yes' for 
'use for all plots'. Change the title of 'default x-axis' to 'time [h]' and the factor to '1/3600' 
to convert seconds into hours. The title of the 'plot #0' should also be changed to 'Phase 
fraction of cementite precipitates' and the title of y-axis to 'Phase fraction'. 
Next, create a new window 'Plot: precipitate distribution - histogram' (p5) window. Select 
'CEMENTITE_P0' from the box which opens and click 'OK'. In the 'options' window, change the 
number of '# size classes' for this histogram to '20'. Set the x-axis label to 'Precipitate radius 
[nm]'. In the 'factor' line for this x-axis, enter '1e9'. This expresses the particle radii in 
nanometres instead of metres, making the scale easier to read. Change the y-axis label to 
'Number of precipitates'. 
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Both the histogram and the plot of phase fraction against time are updated during the calculation, 
so it is possible to follow the evolution of the size distribution and the phase fraction as the 
calculation takes place. 

2. The calculation 

As the introduced number of classes is quite large (as defined in p. 1.D.), it will be beneficial to 
modify the algorithm used for the calculation. To do this the numerical limits describing the 
increase of the nucleation density in the 'convergence control' field should be changed. Up to 
now, this can be only modified via console commands. Type the following command-line in the 
console: 
  
set-simulation-parameter c n b 1,05  
  
Calculate an equilibrium at 600°C in the usual way. Open 'Calc > Precipitate kinetics' or click on 

the icon (keyboard shortcut: 'Ctrl + K'). Enter '3.6e5' as the simulation end time. This is in 
seconds, so is equivalent to 100 hours. Note that in the 'Temperature control' section, an 
isothermal heat-treatment at 600°C has been selected by default; leave this setting as it is. 
To give more frequent updates of the graphs on the screen, the 'Update output every' number 
can be decreased from 100 to 50. However, this will slow down the calculation somewhat, so it is 
probably not advisable on slow machines. Leave the other settings as they are, and click on 'Go'. 
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The information in the 'Output' window gives a summary of the current system composition, 
simulation time 
  
******** isothermal, T=873.16 K (600 C) 
******************************************************************  
1, recs=1; its=1/1, dt=1e-012, time: 1e-012s (2.778e-016h), T=600 C (873.2 K), on 
Tue, 16:40:26 
#Ferrite: BCC_A2, sv=6.13e-010 (sve=6.13e-010), dcf=1 (dt=0, -) 
FE +9.90768e-001(+0.00e+000) C +9.23192e-003(+0.00e+000)  
-----------------------------------------------------------------------------------
----------------------- 
CEMENTITE_P0: nucl-site: d, nucl-dfm=6840.7, ans=4e+021 
+ CEMENTITE_P0 precipitation started at 1.9531e-008 s, T=600 °C (873.16 K)  
  
- First line: 
1 -Number of iterations.  
recs -Number of records in buffer. 
dt -Last time step. 
time -Absolute simulation time in [s]. 
T - Current temperature in [°C] (in [K]).  
- Second line: 
#Ferrite - Precipitation domain, BCC_A2 - matrix phase, 
sv - current vacancy concentration 
sve - equilibrium vacancy concentration 
dcf - diffusion correction factor due to the presence of the excess vacancies 
damping feature (dt=0,-) - maximum time step allowed due to the matrix condition 
  
- Third line: 
FE +9.95367e-001(+0.00e+000) - Composition of matrix 
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- Fourth line: 
CEMENTITE_P0: - Precipitate phase 
( 0/..../0e+000) - (number of classes used / '+', '-' or '.', meaning: New class built, class deleted 
or no change / Number of precipitates for this phase) 
f - mole fraction of precipitate phase 
rm - mean radius of precipitate phase 
dfm - driving force for formation of phase in [J/mol] 
nucl-dfm - driving force for nucleation in [J/mol] 
ans - available nucleation sites 
  
- Fifth line (possible): 
n_dot - nucleation rate 
dt - maximum time step allowed due to the precipitate condition 
  
- Last line: 
+ nucleation of CEMENTITE_P0 started at 0,00152588 s, T=600 °C (873,16 K) - Additional 
information: Nucleation started '+' or stopped '-' and the exact system parameters at that time. 
  
Another output result, at a later stage: 
  
******** isothermal, T=873.16 K (600 C) 
******************************************************************  
2500, recs=299; its=1/1, dt=0.000118979, time: 16.993s (0.00472h), T=600 C (873.2 
K), on Tue, 17:49:51 
#Ferrite: BCC_A2, sv=6.13e-010 (sve=6.13e-010), dcf=1 (dt=0.099, matrix(C)) 
FE +9.99773e-001(+0.00e+000) C +2.27191e-004(+0.00e+000)  
-----------------------------------------------------------------------------------
----------------------- 
CEMENTITE_P0: (250/..gs/1e+020/d) f=0.03605/rm=3.85e-008/dfm=62.0,nucl-dfm=62.0, 
ans=0 
n_dot=0e+000 (ecdf=0.99), mcomp(its:0)=1 (res=0), step: (dt=2.4e-005, rad-
shrink/249)  
2500, recs=277; its=1/1, dt=1,49133, time: 303,923s (0,08442h), T=600 C (873,2 K), 
on Fr, 10:27:17  
#Ferrite: BCC_A2 (dt=6,6, matrix(C)) 
FE +9,99778e-001(+0,00e+000) C +2,21980e-004(+0,00e+000)  
CEMENTITE_P0: (63/..gs/1e+019/d) f=0,03607/dfm=19,8,nucl-dfm=19,2, ans=0 
n_dot=0e+000 (ecdf=1), mcomp(its:20)=1,5e-018 (res=1e-014), step: (dt=3,8e-006, 
rad-shrink/62)  
  
In iteration 2500 above, the maximum time-step is set to 0.099 s to avoid the C content from 
being depleted too fast (matrix(C)). The carbon content of the matrix has decreased from 9.2x10-

3 initially (iteration 1) to 2.3x10-4 in iteration 2500. The precipitate phase uses 250 classes and 
consists of roughly 1x1020 particles. The mole fraction of cementite in the matrix is 0.0361 
(3.61%). There is a small positive driving force for nucleation (62.0 J) and the nucleation rate 
(n_dot) is zero. This is because all nucleation sites are saturated (ans=0). 
To avoid numerical instability, unreasonably large changes, for example in composition, precipitate 
volume, precipitate number or driving force, are prevented. Here, the coarsening stage is in 
progress and small particles are shrinking. A maximum value of radius reduction per time-step is 
imposed (rad-shrink); this reduces the time-step to 2.4x10-5 s for the next step. The calculation 
speed can be increased by setting the windows to 'manual update' so that the graphs are not 
updated. Select 'View-Freeze update' or press 'Ctrl+I' to freeze the currently selected window. 
The same procedure unlocks the window again. To update the window content, press 'Ctrl+U' or 
select 'View-Update all window contents'. 
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3. Interpreting the results 

Nucleation, growth and coarsening 

When the calculation is finished, add three new plots in the same window as the plot of 
F$CEMENTITE_P0 versus time. Drag and drop NUM_PREC$CEMENTITE_P0 (number of cementite 
precipitates) into the first of these, NUCL_RATE$CEMENTITE_P0 (nucleation rate) into the 
second. In the third, add R_MEAN$CEMENTITE_P0 (mean radius), R_CRIT$CEMENTITE_P0 
(critical radius), R_MIN$CEMENTITE_P0 (minimum radius) and R_MAX$CEMENTITE_P0 
(maximum radius). 
These variables can be found under 'kinetics: precipitates' and 'kinetics: nucleation' in the 
'variables' window. 
Using these plots, the different stages of nucleation, growth and coarsening can be identified. 
During the nucleation stage, between 1e-11 and 1e-9 hours, the number of precipitates increases 
rapidly, but since these precipitates are, as yet, extremely small, the phase fraction of cementite 
also remains small. During this stage, the nucleation rate rises initially, due to a positive driving 
force for nucleation, and decreases again to zero when all the available nucleation sites are 
occupied. 
The next stage, from approximately 1e-9 to 1e-6 hours, is the diffusion-controlled growth of these 
nuclei; this continues until the equilibrium phase fraction of cementite reaches its equilibrium 
value, as indicated by the plateau on the 'Phase fraction' curve. The number of precipitates does 
not change during this stage, but there is an increase in radius which can just be detected on the 
plot below. There follows a period in which there is little or no change in any of the three 
parameters.  
Finally, at just over 1e-3 hours onwards, there is the onset of coarsening, which is characterised 
by a decrease in the number of precipitates accompanied by an increase in radius. The critical 
radius rises and becomes larger than the smallest precipitate classes. Therefore these classes start 
to dissolve and the newly available carbon is used to grow the larger precipitates (Gibbs-Thomson 
effect). The critical radius is unstable (leading to a 'noisy' appearance on the graph) because 
whenever a small class is deleted, the carbon content of the matrix rises again, affecting the critical 
radius. 
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Histograms of precipitate size distribution 

The plot above shows only the variation of the mean radius with time, but more detailed 
information on the distribution of particle sizes can be found on the histogram. At the end of the 
calculation, the final size distribution is shown on the histogram. The distribution at other stages of 
the calculation can be recalled using 'Global > Buffers > Edit buffer states'. This brings up a list 
of all the states saved in the memory, with details of time, temperature and time-step. Selecting 
one of these records loads the corresponding particle size distribution into the histogram if the 
'auto load' box at the bottom left is ticked. Otherwise, it can be loaded by clicking on the 'load 
selected' button. 
  

 
  
In the final part of this tutorial, the precipitate size distribution as calculated by MatCalc will be 
compared with the Lifshitz-Slyozov-Wagner (LSW) distribution given by the following equation: 
  

 
  
Create a new plot in the histogram window for CEMENTITE_P0 and set the number of classes on 
the histogram to 20 as before. In the options under 'plots', select 'density' for 'scale frequency' 
and 'yes' for 'scale radius'. Set the scaling of the x-axis as '0..1.499' because the LSW function 
is only defined between 0 and 1.5. 
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Enter the LSW function, either using the 'Functions and Variables' box or by using the following 
command-line in the console: 
  
set-function-expression LSW x^2*(3/(3+x))^(7/3)*((3/2)/(3/2-x))^(11/3)*exp(-x/(3/2-
x))*4/9 
  
Then add the function to the scaled plot, either using the right-click menu in the Options window to 
add a new 'function/expression' series (as it was done in Tutorial 6) or by using the following 
command-line: 
  
set-plot-option . s n f LSW 0..1.5 
  
The plot below shows a comparison between the LSW function and the histogram simulated by 
MatCalc. 
  

 

 

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t6
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T15: Effect of microstructure and conditions (Part 1) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb; mc_sample_fe.ddb 
Click here to view the script for this tutorial 
  
  
The Fe-Cr-C system forms the basis of many industrially useful alloys. The aim of this and Tutorial 
16 is to produce a simulation of the precipitation behaviour in a Fe-9Cr-0.1C (wt.%) alloy during 
heat-treatment at 600°C. This involves considering several aspects, such as the chemical 
compositions of nuclei, the microstructural sites on which nuclei form, and the density of these 
sites in the microstructure under consideration. This first of two tutorials will focus on modelling the 
formation of the metastable cementite (Fe3C) phase, and Tutorial 16 will consider the interaction 
between this and the more stable phase M23C6. 

Contents: 

• Choice of nucleation model 
• Diffusivity in precipitates  
• Nucleation sites for the precipitate phase  
• Microstructural parameters of the precipitation domain  

Equilibrium calculations 

Create a new workspace with the elements Fe, C and Cr and the phases BCC_A2, CEMENTITE and 
M23C6. Enter the composition 9 wt.% Cr, 0.1 wt.% C. 
Calculate an equilibrium at 600°C and observe the contents of the 'Phase summary' window. It 
can be seen that M23C6 is the stable phase at equilibrium. However, it is known from experience 
that the first phase to form on heat-treatment is cementite. 
Go to 'Global > Phase status' and suspend the 'M23C6' phase so as to study the metastable 
equilibrium between BCC_A2 and cementite. The composition of cementite in metastable 
equilibrium with BCC_A2 is, in wt.%, 84 % Cr, 7 % C, 9 % Fe; this is very rich in Cr compared to 
the overall system composition of 9 % Cr, 0.1 % C and 90.1 % Fe.  
In practice, it is found that cementite forms rapidly on heat-treatment at 600°C; this is more 
consistent with a mechanism which primarily involves the diffusion of C rather than the slower-
diffusing Cr. It is therefore likely that the initial nuclei do not form with the equilibrium 
composition, but are initially much richer in Fe than Cr. Part 1 of this tutorial considers how such 
effects can be modelled. Re-open 'Global > Phase status' and remove the 'suspended' flag for 
M23C6. 

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t15:script:t15.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t16
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t16
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t16
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1. Nucleation model for cementite 

Setting up the simulation 

Create a precipitate phase CEMENTITE_P0, using 'Global > Phase status'. In the 'Precipitate' 
tab, set the number of size classes to '25', and in the 'Nucleation' tab, set the nucleation sites to 
'Dislocations' and change the 'Nucleus composition' model from 'ortho-equilibrium' to 
'para-equilibrium' using the drop-down menu. 'Para-equilibrium' means that the nucleus is 
assumed to have the same composition in terms of substitutional elements as the matrix from 
which it forms, and only the carbon is partitioned between the two phases. In the 'ortho-
equilibrium' model, by contrast, the composition of the nucleus is calculated assuming full 
equilibrium with the BCC_A2 matrix. 
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In 'Global > precipitation domains', create a new domain named 'ferrite' with 'BCC_A2' as its 
matrix phase. Click on 'Attach', select 'CEMENTITE_P0' and click 'OK'. The system is now set up 
so that cementite can precipitate in this domain. Accept the changes by clicking 'OK' to close the 
window.  
  

 
  
Load the mobility data as described in Tutorial 14. 

Graphical display of results 

Create a new XY-plot window and define a default x-axis with the following properties: 

• Use for all plots: yes  
• Title: Time [h]  
• Type: log  
• Scaling: 1e-10..  
• Factor: 1/3600 (to convert seconds to hours)  

Add four new plots to the window and drag and drop the following series to the plots: 

1. F$CEMENTITE_P0 
2. X$CEMENTITE_P0$CR (Cr content of the cementite precipitate phase) and 

X_NUCL$CEMENTITE_P0$CR (Cr content of the nucleus). The latter can be found under 
'kinetics: nucleation'.  

3. X$BCC_A2$C (carbon content of BCC matrix)  
4. NUM_PREC$CEMENTITE_P0  
5. R_MEAN$CEMENTITE_P0  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t14
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Label the y-axes as follows  

1. 'f<sub>CEM</sub>' (fCEM)  
2. 'x<sub>Cr</sub>' (xCr)  
3. 'x<sub>BCC_A2, C</sub>' (xBCC_A2, C)  
4. 'N<sub>ppt</sub> [m<sup>-3</sup>]' (Nppt [m

-3])  
5. 'R<sub>mean</sub> [m]' (Rmean [m]); y-axis set to 'log' 

Save the workspace. 

Calculation 

Select 'Calc > precipitate kinetics'. Enter the finish time of the calculation: '3.6e13' s (= 1e10 
hours). The isothermal treatment temperature should be set to '600' and 'Temperature in C' 
selected. Leave the other settings as they are, and click on "Go". (The calculation may take some 
time, especially on slower machines, because of the long treatment time.)  
After the calculation has finished, duplicate and lock all the series in the plot window. Return to 
'Global > Phase status' and set the nucleation model for CEMENTITE_P0 to 'ortho-equilibrium' 
and re-open 'Calc > precipitation kinetics'. There is no need to change anything; simply click on 
'Go'. A warning appears that the contents of the current buffer will be overwritten. As the series 
have been locked, this does not matter; accept the warning with "Yes". 

Interpretation of results 

The onset of precipitation occurs much earlier in the para-equilibrium case, beginning around 1e-7 
hours (~ 1e-3 seconds), as compared to ~1 hour for ortho-equilibrium. The para-equilibrium 
cementite fraction reaches a plateau at a smaller value than for the ortho-equilibrium case, but 
after a longer time at temperature, this fraction rises, eventually reaching the same value as for 
ortho-equilibrium. 
  

 
  
The para-equilibrium model stipulates that the Cr content of the nuclei (XNUCL,CEM, Para) be equal to 
that of the matrix. This decreases towards longer times at temperature, as the matrix becomes 
depleted in Cr. This depletion is caused by the Cr-enrichment of the precipitates by diffusion; their 
Cr content (XCEM, Para) increases up to the equilibrium value of around 0.69 (mol. fr.). 
In the ortho-equilibrium case, the cementite nucleates with its equilibrium Cr content, and there is 
little or no change in the Cr content of the precipitates during the heat-treatment. It is this 
requirement for full equilibrium which accounts for the long incubation time for cementite when the 
ortho-equilibrium model is used; the formation of a critical nucleus with ortho-equilibrium 
composition requires the (slower) diffusion of Cr. 
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In the plot of X$BCC_A2$C (the carbon content of the BCC matrix), it can be seen that the 
depletion of the matrix in carbon exactly follows the increase in precipitate fraction for both 
models. 
  

 
  
The plot of the number of cementite precipitates shows that in the ortho-equilibrium case, 
nucleation occurs at a later stage and the precipitates are less numerous.  
 

 
  
Coarsening of the precipitates is more rapid in the para-equilibrium case, as can be seen from the 
plot below: 
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The use of the para-equilibrium nucleation model gives better qualitative agreement with 
experimental observations of the rapid precipitation of cementite at temperatures such as 600°C in 
alloy steels. An example in the Applications section, in which this issue is considered in more detail, 
will be available shortly. 
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2. Diffusivity in precipitates 

Setup 

It was seen above that, using the para-equilibrium model, cementite precipitates formed with a Fe-
rich composition and subsequently enriched in Cr. The rate of enrichment depends on the ease with 
which chromium can diffuse into existing precipitates.  
Duplicate and lock all the series in the plots. Re-open 'Global > Phase status'. In the 
'Nucleation' tab, set the cementite nucleation model to back to 'para-equilibrium'. Open the 
'Special' tab. In the 'Diffusion in precipitate' section, 'consider as ratio from matrix 
diffusivity' is selected by default, and the value of the ratio set to 0.01. This means that the 
diffusivities of all elements within the cementite precipitate are considered to be one hundredth of 
their values within the matrix. Changing this value will affect the rate of Cr-enrichment of the 
cementite. To demonstrate this, change the value of the ratio to '0.25', click on 'OK' and re-run 
the simulation. 
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Interpretation of results 

In this case, precipitation occurs at the same rate as in the first para-equilibrium calculation, but 
the Cr-enrichment of the precipitates is more rapid. Consequently, the increase in precipitate phase 
fraction and the decrease in matrix carbon content occur earlier. It is also notable that coarsening 
is delayed and the distribution of more numerous, relatively fine particles is stabilised to longer 
times, as shown by the two plots below. 
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3. Microstructural parameters and nucleation sites 

Setup 

At this stage, it may be helpful to remove all the series except the original para-equilibrium 
calculation results from the plots to avoid them becoming cluttered. (If required, the numerical 
data from the series can first be exported in text form using 'Copy data' from the right-click menu 
and then pasting these data into a spreadsheet or text editor. Alternatively, the plots can be 
exported in graphical form using 'Copy pixmap'.) To remove a series from a plot, first click on 
that plot and then select the name of the series in the 'Options' window. (Failure to do this can 
result in series from other plots being deleted instead.) Multiple series can be selected using the 
Ctrl button. Remove them using the Delete button or 'Remove series' from the right-click menu. 
Reset the 'consider as ratio from matrix diffusivity' value back to its default value of '0.01' in 
the 'Special' tab, keep the nucleus composition model set at 'para-equilibrium' and click 'OK' to 
save the changes. 
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Open 'Global > precipitation domains' and click on the 'Structure' tab. The default values for 
each of the structural parameters are shown in the image below. 
  

 
  
The nucleation sites for CEMENTITE_P0 have been set to 'Dislocations' (see Part 1 of this tutorial) 
so the dislocation density will determine the number of nucleation sites. The default dislocation 
density, which has been used so far, is 1e12, which is typical of an annealed structure. Change this 
value to '1e14' and re-run the simulation. 
The following images show the phase fraction, the number of precipitates (note the log scale) 
and the mean radius for dislocation densities of 1e12, 1e14 and 1e16. It can be seen that 
increasing the nucleation site density accelerates the reaction kinetics and results in a larger 
number of precipitates with a smaller mean radius. 
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To finish... 

Save the workspace file. 
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T16: Effect of microstructure and conditions (Part 2) 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb; mc_sample_fe.ddb 
Click here to view the script for this tutorial 
  

Contents: 

• Simultaneous precipitation of two phases 
• Effect of dislocation density  
• Effect of grain diameter  
• Subgrains and elongation factors  

Before starting... 

Re-open the workspace saved from Tutorial 15 and save it under a new name.  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t16:script:t16.mcs
http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t15
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1. Simultaneous precipitation of cementite and M23C6 

Setup 

Open 'Global > Phase status' and create a precipitate phase from M23C6. In the 'precipitate' 
tab, enter '25' for the number of size classes, and attach the phase to the domain 'ferrite'. In the 
'Nucleation' tab, set the nucleus composition model to 'ortho-equilibrium', and the nucleation 
sites to 'Grain boundaries'. 
In 'Global > Precipitation domains > Structure', reset the dislocation density to its default 
value of '1e12' m-2. The default grain diameter is '100e-6' m, and it is this which governs the 
density of M23C6_P0 nucleation sites. Create a new XY-plot window with five plots in it, and insert 
series into them as follows: 

1. F$CEMENTITE_P0, F$M23C6_P0 (fraction of cementite and M23C6 precipitated, 
respectively) 

2. X$CEMENTITE_P0$CR, X$BCC_A2$CR (Cr content of cementite precipitates and matrix, 
respectively) 

3. X$BCC_A2$C (C content of matrix) 
4. NUM_PART$CEMENTITE_P0, NUM_PART$M23C6_P0 (number of cementite and 

M23C6 precipitates, respectively) 
5. R_MEAN$CEMENTITE_P0, R_MEAN$M23C6_P0 (mean radius of cementite and M23C6 

precipitates, respectively) 

Run the kinetic simulation, with an isothermal heat treatment at 600°C as before, and an end time 
of 3.6e+10 s. 

Interpretation of results 

Plot 1: Cementite appears rapidly and reaches a steady-state precipitate fraction. M23C6 starts to 
form after around 1 hour at 600°C; this is at the expense of cementite, which redissolves. By the 
end of the simulation, all the cementite has dissolved and M23C6 has reached its equilibrium phase 
fraction. 
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Plot 2: This shows that cementite enrichment has just started by the time the cementite phase is 
being dissolved. 
  

 
  
Plot 3: The depletion of the matrix in carbon occurs in two stages. The first of these corresponds to 
the formation of cementite, and the second to the formation of M23C6. 
  

 
  
Plot 4: The number of M23C6 precipitates is comparable with that of cementite precipitates. The 
reduction in the number of cementite precipitates is both due to the coarsening and the phase 
dissolution stages: 
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Plot 5: There is an intermediate stage between the growth and coarsening phases for the 
cementite precipitates (plateau between 10-6 - 10-3 hours). The maximal size of the cementite 
precipitates is in the micrometer range.  
  

 

  

2. Effect of dislocation density 

Duplicate and lock the series and re-run the simulation with a dislocation density of 1e14 m-2, 
leaving the grain size the same.  

Results: 

The onset of cementite precipitation occurs earlier with a higher dislocation density, but the 
kinetics of cementite dissolution and of M23C6 precipitation are unchanged. The plot below shows a 
significant increase (note log scale) in the number of cementite precipitates formed. 
  

 
  
With a higher dislocation density, the cementite particles do not become so large during the growth 
stage. However, coarsening begins earlier, and the curve of radius versus time for the coarsening 
precipitates eventually becomes parallel with that for the lower dislocation density. 
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3. Effect of grain diameter 

Reopen 'Global > Precipitation domains > Structure'. Reset the dislocation density to 1e12 m-

2, set the grain diameter to 10e-6 m and re-run the simulation. 

Results: 

As might be expected, reducing the grain diameter accelerates the precipitation kinetics of M23C6, 
by providing more nucleation sites. It also accelerates the dissolution of cementite, which begins to 
dissolve when M23C6 starts to precipitate. 
  

 
  
The plot below shows the effect on the number of M23C6 of reducing the grain size from 10-4 to 10-5 
m. The number of M23C6 increased due to more nucleation sites available.  
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In the plot of radius against time, the maximum cementite radius attained is reduced, because 
there is less time available for coarsening of this phase before dissolution sets in. 
  

 

  

4. Subgrains and elongation factors 

In the 'Global > Precipitation domains > Structure', the other adjustable parameters in the 
'Microstructure parameters' section are: 

• Grain size elongation factor, i.e. aspect ratio of grains. This is useful in, for example, 
extruded structures, in which grains tend to be elongated in the direction of extrusion. 

• Subgrain diameter. Subgrains are structures such as the packets and blocks of 
martensite in prior austenite grains, or polygonised structures formed during recovery of 
cold-worked materials. In the 'Global > Phase status > Nucleation' tab, subgrain 
boundaries as well as grain boundaries, can be selected as nucleation sites.  

• Subgrain size elongation factor: analogous to the grain size elongation factor, for 
subgrains. 

Re-open 'Global > Phase status > Nucleation'. In the 'Nucleation sites' section for 
M23C6_P0, select 'subgrain boundary' in addition to 'grain boundary', to allow this phase to 
nucleate on subgrain as well as grain boundaries. The default subgrain size in 'Global > 
Precipitation domains > Structure' is 1e-6 m; accept this value and re-run the simulation. 
The plots below compare calculations in which the dislocation density is 1e-12 m-2 and the grain 
diameter is 10e-6 m, with and without nucleation on subgrain boundaries (s. g. b.). It can be seen 
that providing an additional set of nucleation sites accelerates the M23C6 precipitation kinetics, 
increases slightly the number of M23C6 precipitates, and has some effect on the maximum value of 
mean radius attained by cementite precipitates before they redissolve. 
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Elongated subgrains, obtained by increasing the subgrain elongation factor to 10, have a very small 
effect on precipitation and coarsening rates but influence the number of precipitates. 
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T17: Complex multi-stage heat treatments 

This tutorial was tested on 
MatCalc version 5.43 rel 1.013 
license: free 
database: mc_sample_fe.tdb; ; mc_sample_fe.ddb 
Click here to view the script for this tutorial 
  
  
In this tutorial, we simulate the precipitation of NbC in the solid state during the continuous casting 
of steel and the subsequent austenitization treatment. The austenite / ferrite transformations of 
the matrix phases are taken into account. The continuous casting simulation starts at 1400°C with 
linear cooling to room temperature. the austenitization treatment is carried out at 1100°C for 2 
hours. Heating and cooling rates are assumed to be 1 K/s. Furthermore, we assume that 
precipitation of NbC occurs only at austenite grain boundaries in the austenite during continuous 
casting. After transformation to ferrite, we assume that precipitation occurs at grain boundaries 
and dislocations. 
  

Contents: 

• Definition of complex heat treatments 
• The heat treatment editor 
• Multiple precipitation domains / matrix phase transformations 

  

http://matcalc.tuwien.ac.at/wiki/lib/exe/fetch.php?media=tutorials:t17:script:t17.mcs
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1. Setting up GUI, thermodynamics, precipitates and precipitation 
domains  

Setup calculation 

Create a workspace with the elements Fe, Nb and C and the phases BCC_A2 and FCC_A1. Enter 
the composition 0.1 wt.% C, 0.7 wt.% Nb. Create a precipitation domain named 'austenite' with 
the phase FCC_A1 as its matrix, and a precipitation domain named 'ferrite' with the phase 
BCC_A2 as its matrix. Create a precipitate phase FCC_A1#01_P0. Enter 25 as the number of size 
classes for this phase, and attach it to the 'austenite' domain. The phase status dialog should look 
somehow like the figure below. Leave all the other settings at their default values. Read in the 
mobility data. 
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Setup GUI 

Create a new XY-plot window with four plots in it. Use a default x-axis and set the axis type to 
'log'. Scale from '10..'. The axis title is 'time / s'. Insert series into the plots as follows: 

1. T$C (temperature in celsius), y-axis title 'Temperature [°C]'. 
2. F$FCC_A1#01_P0 (phase fraction of NbC), y-axis title 'NbC phase fraction'. 
3. R_MEAN$FCC_A1#01_P0 (mean radius of NbC), y-axis title 'mean radius [nm]', 

scaling '0.1..' and 'log' type. Factor is '1e9' to display the radius in nm instead of m. 
4. NUM_PREC$FCC_A1#01_p0 (number density of NbC), y-axis title 'number density 

[m<sup>-3</sup>]'. axis has 'log' type and the scaling is set '1..'. 

  

2. Definition of the heat treatment 

Open 'Global -> Heat treatments ...'. This dialog represents a very useful editor for definition of 
complex heat treatments by a sequence of linear heat treatment segments.  
  

 
  
Firstly, create a new heat treatment 'New ...' with the name 'sample_ht'.  
  
Since the present steel will transform from austenite to ferrite during the cooling process, we start 
with setting up a linear cooling segment from 1400°C to transformation temperature with a cooling 
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rate of 1 K/s. Let us assume that this transformation occurs instantaneously at 600°C. Create a 
new segment with the button 'New segment'. Double-click the new line in the 'Data...' list box or 
highlight the line and press 'Edit'. In the following dialog, you can define the properties of the heat 
treatment segment. First of all, enter 'Start temperature' 1400°C. Then, in the temperature 
definition mode combo box, you can select which data you want to provide to define the segment. 
Since we want to cool to RT and know the cooling rate, we select 'End temperature & 
Heat/Cooling rate'. 'End temperature' is 600°C and 'Cooling rate' is -1.  
  
The next important setting is the definition of the number of states to store during the calculation. 
By default, each segment stores 25 states with linear interval distances. Optionally, you can select 
logarithmic. Remain with the default settings.  
  
Finally, select the precipitation domain for the segment, in our case 'austenite'. The dialog should 
now appear like this: 
  

 
  

To set up the next segment, press the  button. The start temperature for each following 
segment is automatically set to the end temperature of the previous segment, that is 600°C. Enter 
the new end temperature (25°C) and select ferrite for the precipitation domain. The second 
segment should look like this: 
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Continue to define the rest of the segments: 
  

1. Segment from RT to 850°C with 1 K/s heating rate. Since the precipitation domain does 
not change, select the 'inherit from previous segment' radio button. We assume that 
the ferrite to austenite transformation occurs at 850°C. 

2. Next segment from 850°C to 1100°C, however, with austenite as the precipitation domain. 
3. an isothermal segment for two hours at 1100 °C. This time, the temperature definition 

mode is 'End temperature & Delta-Time'. End temperature is 1100°C and 'Delta-time' 
is 7200 s. 

4. Define a cooling segment down to 600°C in austenite matrix (cooling rate 1 K/s). 
5. Finish with a segment from 600°C to RT having ferrite as a matrix (cooling rate 1 K/s). 

If you have finished entering the segments, the entire heat treatment should look like this: 
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The last thing that we have to take care of is the changing nucleation sites for the NbC precipitates. 
According to our problem, we want to simulate NbC precipitation during cooling from continuous 
casting along the austenite grain boundaries. For all other parts of the heat treatment, we want to 
allow precipitation at grain boundaries and dislocations simultaneously.  
  
This issue can be solved easily with the use of scripting commands that can be entered at the 
beginning and end of each of the heat treatment segments. Edit the first segment by double 
clicking it in the list. In the edit field for the pre-segment script, enter the command just as if you 
would do in the MatCalc console: 
  
set-precipitation-parameter fcc_a1#01_p0 N S G 
  
This command defines the (n)ucleation (s)ites of the NbC to be at grain boundaries. Since only 
grain boundaries are selected, please note that MatCalc will then use the diffusion geometry for 
grain boundary precipitates, which has been introduced MatCalc version 5.14. The following images 
show the two different diffusion geometries of MatCalc: 
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Since we want to continue with different nucleation sites after the first cooling segment, we define 
a post-segment script for the first segment reading 
  
set-precipitation-parameter fcc_a1#01_p0 N S DG 
  
This command will define dislocations AND grain boundaries as nucleation sites. MatCalc will then 
automatically use the spherical diffusion geometry again as shown in the left image. 
  
The existence of pre-segment and post-segment scripts is indicated by the letter 'Y' in the heat 
treatment editor. 
  
Save your file ('tut17.mcw'). 
  

3. Perform simulation 

Start the precipitation simulation with 'Calc -> Precipitate kinetics ...'. In this dialog, the most 
important setting is the 'temperature control' selection. Select 'from heat treatment' and 
'sample_ht'. It is not necessary to enter the simulation end time because MatCalc will 
automatically stop when reaching the end of the heat treatment segments. 
  
Start the precipitation simulation with the 'Go' button. 
  
After reaching the end of the heat treatment, the results look like follows: 
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The temperature plot on top shows the expected profile. The next plot with the NbC phase fraction 
shows a strong increase of the phase fraction at around 200 s, where the specimen reaches about 
800°C on heating. Later, during austenitization, the phase fraction is decreased slightly because 
the solubility of the Nb and C is increased. The phase fraction remains almost constant during the 
rest of the process. 
  
When looking at the plots for the mean radius and the number density of the NbC precipitates, 
interpretation of the results is more difficult. First, nucleation starts and proceeds until 100 s. The 
nucleation stops because there are no more available nucleation sites at the grain boundary. Up to 
approximately 800 s, the existing NbC precipitates only grow. After switching to ferrite and adding 
dislocations as additional nucleation sites, the number density quickly increases in a burst of 
nucleation events. At the same time, the mean radius drops drastically, which is at first sight 
unexpected. However, since the plot displays the mean radius of the precipitate population, 
generation of a large number of new and small precipitates will decrease the mean value to the 
value of the highest number of precipitates. Later, in two more steps, the radius increases again 
due to growth as well as dissolution of a part of the small precipitates generated in the second 
nucleation burst. 
  
Apparently, interpretation of this kind of simulation suffers from the fact that two different kind of 
precipitate populations, namely the one on the austenite grain boundaries and the other on the 
dislocations are treated as one. In the following section, a method of separation of populations is 
used that can be very useful in complex simulations.  
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4. Simulation with separation of precipitate populations 

On many occasion, it can be useful to separate populations of one and the same precipitate type to 
facilitate interpretation of the results. For the present example, this is easily done by introduction 
of an additional precipitate phase FCC_A1#01_P1. Create an additional precipitate based on the 
FCC_A1#01 parent phase in the 'phase status ....' dialog. Highlight the FCC_A1#01 phase and 
press 'Create ...' for a new precipitate phase.Go to the 'Precipitate' tab and initalize the new 
phase with 25 classes. 
  
Note that the suffix '_P1' of the new phase indicates that the precipitate is identical to the '_P0' in 
terms of its nucleus composition, however, it contains precipitate classes that can have appeared 
at different stages of the heat treatment.  
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Let us now set up the simulation such that the _P0 phase can only nucleate in the first segment of 
the heat treatment, that is cooling in the austenite, while the '_P1' population is not allowed to 
form. This can be done by defining 'nucleation sites' as 'none'. For all consecutive segments, 
nucleation of further '_P0' precipitates will be suppressed while the '_P1' population can nucleate at 
grain boundaries and dislocations. Make the following changes to the pre-segment and post-
segment scripts of the first segment in the heat treatment editor: 
  

 
  

 
  
Run the simulation again and modify the plots to display the properties of both precipitate 
populations. The result should look like this: 
  
  

 
  



Tutorial 17 

 159
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Major advantage of simulations with separated precipitate populations is the ease of interpretation 
of the results. The second simulation clearly shows that the precipitates that are formed during 
cooling in the austenite grow to large size and remain almost unaltered during the later stages of 
the heat treatment. On the other hand, their phase fraction and number density is low, which 
indicates that their contribution to mechanical properties in terms of precipitation strengthening will 
be negligible. The second population appears in high number density and with small radius of 
approximately 10 nm. Moreover, the phase fraction is high, indicating a strong potential for 
precipitation strengthening of this second wave of NbC precipitates. 
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T18: Plotting a TTP diagram 

This tutorial was tested on 
MatCalc version 5.41 rel 1.005 
license: free 
database: mc_sample_fe.tdb; ; mc_sample_fe.ddb 

Contents: 

• Calculating a TTP diagram for isothermal treatments 
• Calculating a TTP diagram for continuous cooling  
• Plotting the diagram  
• Display options: absolute, relative or relative to maximum phase fraction  

A time-temperature-precipitation diagram is a plot consisting of contours characterising the extent 
of a precipitation reaction on axes of temperature versus time. In this tutorial, a TTP diagram will 
be calculated for the precipitation of NbC in the austenite single-phase region. 
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1. Setting up the system 

Create a workspace with the elements Fe, Nb and C and the phases BCC_A2 and FCC_A1. Enter 
the composition 0.1 wt.% C, 0.7 wt.% Nb.  
Firstly, it is necessary to determine the extent of the austenite single-phase region in which the 
TTP diagram is to be calculated. To do this, first calculate an equilibrium at 1000°C and then search 
for the BCC_A2 phase boundary (referring to Tutorial 7 if necessary). This gives a temperature of 
903.51°C for the zero-phase-fraction boundary of BCC_A2. This is the upper boundary of the low-
temperature 'alpha' form of ferrite. Next, calculate another equilibrium at 1200°C and repeat the 
procedure. This time, the temperature value found is 1439.01°C, which is the lower boundary of 
the high-temperature 'delta'-ferrite. Between these two limits, the only stable matrix phase is 
austenite (FCC_A1). 
Create a precipitation domain named 'austenite' with the phase FCC_A1 as its matrix, and a 
precipitate phase FCC_A1#01_P0. Enter '25' as the number of size classes for this phase, and 
attach it to the 'austenite' domain. Its precipitation sites should be dislocations. Leave all the 
other settings at their default values. Read in the mobility data. 

2. TTP diagrams for isothermal heat treatments 

Calculations of phase fraction for isothermal treatments 

The plot below, obtained using a stepped equilibrium calculation, shows the equilibrium phase 
fraction of NbC between 925 and 1425°C: 
  

 
  
The plot below illustrates the origin of the typical C-shaped curves of TTP plots. It was obtained 
using 'Calc > Precipitation kinetics' to simulate an isothermal heat treatment at 925°C, plotting 
the series F$FCC_A1#01_P0 on a logarithmic x-axis, then duplicating and locking this series 
before making further calculations in the same way at a selection of other temperatures. At each 
value of temperature, the phase fraction of NbC increases with time before reaching a plateau 
when the equilibrium phase fraction of NbC at that temperature is attained. It can be seen that, 
between 1025 and ~1125°C, the rate of reaction first increases (characterised by a shift of the 
curve towards the left), goes through a maximum, then decreases again. TTP diagrams plot the 
time taken to reach a particular point in a reaction at different temperature values. It can be seen 
from the plot below that if, for example, the time taken to reach 90% of the plateau value were 
plotted for each temperature on axes of temperature versus time, the resulting curve would be C-
shaped. The TTP diagram calculation function of MatCalc allows automatic calculation of curves of 
this type. 
  

http://matcalc.tuwien.ac.at/wiki/doku.php?id=tutorials:t7
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Automatic calculation of TTP diagrams  

Open 'Calc > TTP-diagram' and enter '1425' as the start temperature and '925' as the stop 
temperature. The end time should be sufficient for the phase fraction to reach a plateau at all 
temperatures under consideration. (This can be verified by creating an XY-plot of 
F$FCC_A1#01_P0 versus time and monitoring this during the TTP diagram calculation.) 
In the 'Calculation method' area, select 'isothermal' and enter a value of 25 for 'delta T'. 
Calculations will now be performed every 25 degrees between 1425 and 925°C. 
Note: The calculation in the whole range may take more than 30 minutes (depending on your PC 
capacity). In case you would not spend so much time on this tutorial constrain the temperature 
range (e.g. 925°C - 1225°C) 
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Plotting the results 

When the calculation has finished, create a new window of type '(p6) Plot: TTP-diagram'. In the 
'options' window, expand the 'plots' section and right-click in the area under 'plot#0' to show 
the context menu. Select 'new series' and choose 'ttp-curve' from the sub-menu on the right. 
Next, it is necessary to decide on the type of TTP contours required. The three options are: 

• Absolute: the contours correspond to different values of the phase fraction 
F$FCC_A1#01_P0. 

• Relative: a contour with a value of 'x' for a particular temperature denotes the time at 
which the ratio of F$FCC_A1#01_P0 to its maximum value at that temperature is equal to 
'x'. The maximum values of F$FCC_A1#01_P0 are approximately equal to the equilibrium 
phase fractions F$FCC_A1#01 shown above. 

• Relative max f: in this case, contour values represent ratios of F$FCC_A1#01_P0 to its 
maximum value overall. These contours have a similar form to the 'absolute' contours, 
but different numerical values. 

Select 'relative' from the 'refer to f' drop-box at the top of the 'options' window. Then expand 
the 'series' section of 'options', which should look as shown in the image below. Select the phase 
FCC_A1#01_P0 from the 'phase' drop-box and enter '0.05' into the 'y-data' line. 
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Add two more series to show the contours for ratios of 0.5 and 0.95 on the same diagram. The 
resulting diagram should look like this: 
  

 
  
The following two plots are examples of the other types of TTP diagram. (TIP - to create more than 
one type of TTP diagram in the same plot window, lock all the series in the first diagram, then 
change the diagram type in the 'refer to f' drop-box to plot the next diagram.) 

Absolute 

In the plot below, the contours correspond to different values of the phase fraction 
F$FCC_A1#01_P0. Note that the higher values are only attained at lower temperatures, because 
the equilibrium value of F$FCC_A1#01 decreases with increasing temperature. The maximum value 
of F$FCC_A1#01_P0 is around 7.8e-3. 
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Relative max f 

This diagram has a similar appearance to the 'absolute' diagram above, but the contours now 
represent different ratios of F$FCC_A1#01_P0 to its maximum value. 
  

 

3. TTP diagrams for continuous cooling 

TTP diagrams can also be calculated under conditions of a constant rate of temperature change. 
The diagram below shows several curves of phase fraction versus time for the temperature interval 
from 1425 to 925°C calculated with different cooling rates. It can be seen that the fraction 
precipitated is greater when cooling is slower, because the reaction has more time in which to 
occur. 
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Continous-cooling TTP diagrams can be calculated as shown below. Enter a large value for the end 
time, otherwise this may cause the calculation to end before the stop-temperature is attained when 
slow cooling rates are used. Select 'continuous' in the 'calculation method' section and enter 
the '0.0001' and '1000' as the minimum and maximum cooling rates respectively, and '5' as the 
'delta Tdot factor'. Click 'OK' to start the calculation. 
  

 
  
In the same way, the results can be displayed as absolute, relative or relative to the maximum 
phase fraction. The plot below shows contours of absolute values of phase fraction. In this case, 
logarithmic values have been used. 
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The image below is a 'relative'-type plot, in which the contours represent the ratio of 
F$FCC_A1#01_P0 at a particular cooling rate to its maximum value attained at that cooling rate. 
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